
HP Operations Smart Plug-in for SAP 

for HP Operations Manager for Linux 

Software Version: 12.00 
Installation and Configuration Guide

Document Release Date: December 2009 
Software Release Date: December 2009 



Legal Notices 

Warranty 

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein. 

The information contained herein is subject to change without notice. 

Restricted Rights Legend 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license. 

Copyright Notices 

© Copyright 2009 Hewlett-Packard Development Company, L.P. 

Trademark Notices 

Acrobat®, Adobe®, and PostScript® are trademarks of Adobe Systems Incorporated.


Intel®, Itanium®, and Pentium® are trademarks or registered trademarks of Intel Corporation or its 

subsidiaries in the United States and other countries.


Java™ is a U.S. trademark of Sun Microsystems, Inc.


Microsoft®, Windows®, and Windows NT® are U.S. registered trademarks of Microsoft Corporation.


Oracle is a registered trademark of Oracle Corporation and/or its affiliates.


UNIX® is a registered trademark of The Open Group.
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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software.


To check for recent updates, or to verify that you are using the most recent edition of a document, go to:


http://h20230.www2.hp.com/selfsolve/manuals 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 
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Support 

You can visit the HP Software Support web site at: 

http://www.hp.com/go/hpsoftwaresupport 

HP Software Support Online provides an efficient way to access interactive technical support tools. As a 
valued support customer, you can benefit by using the support site to: 

• Search for knowledge documents of interest


• Submit and track support cases and enhancement requests


• Download software patches


• Manage support contracts


• Look up HP support contacts


• Review information about available services


• Enter into discussions with other software customers


• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in. Many also require a

support contract.


To find more information about access levels, go to:


http://h20230.www2.hp.com/new_access_levels.jsp 

For more information about HP Passport, go to: 

http://h20229.www2.hp.com/passport-registration.html 
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1 Introduction to the HP Operations Smart Plug-in 
for SAP 
This chapter provides an overview of the basic concepts necessary to understand the HP 
Operations Smart Plug-in for SAP (SPI for SAP). The information in this section describes 
how the SPI for SAP integrates with HP Operations Manager (HPOM) for UNIX and other 
HP software products and helps you understand how to customize both the SPI for SAP and 
other HP software products to meet the needs of your environment. 

The SPI for SAP is a software package linking SAP NetWeaver to HPOM. The union offers a 
complementary and consolidated view of SAP performance information and overall resource 
characteristics. 

This integration allows the correlation of SAP performance data with the performance data of 
the operating system, the database, and the network—all from one common tool and in one 
central management system. Integrating SAP performance data with the HPOM 
environment helps you detect and eliminate bottlenecks in a distributed environment. In 
addition, the integration allows for system optimization and service-level monitoring. The SPI 
for SAP performs the following tasks in a distributed HPOM environment: 

•	 Collects real-time information about events and configuration—including useful on-line 
instructions for fast problem resolution 

•	 Monitors SAP nodes to detect potential problem areas and keep track of systems and 
events 

•	 Collects performance data to ensure system throughput and notifies you of any 
performance bottlenecks 

•	 Provides a direct, context-sensitive access to the SAP front-end 

•	 Complements and extends the SAP Computing Center Management System (CCMS) 

•	 Stores events and action records for all SAP managed nodes into a central repository 

•	 Runs routine SAP management tasks 

•	 Integrates SAP environments with the service map—the SPI for SAP includes a policy 
that automatically generates service views of the SAP systems installed on your managed 
nodes. 
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Components of the SPI for SAP 

The SPI for SAP components include tools and policies that allow you to configure and receive 
data in the form of service problem alerts, messages, and metric reports. The SPI for SAP 
service map alerts are shown in the HPOM service map, while SPI for SAP messages and 
automatic action reports are available through the HPOM message browser. 

Tools 

In conjunction with HPOM, the SPI for SAP offers centralized tools, that help you monitor 
and manage the SAP systems. The SPI for SAP tools enable you to configure the management 
server’s connection to selected server instances on specific managed nodes. The SPI for SAP 
tools include the tools for administrating and operating the SPI for SAP. 

To access the SPI for SAP tools, open the Tool Bank window and click SPI for SAP:Tools. The 
following are the SPI for SAP tools: 

•	 SAP R/3 Admin - SAP R/3 Administration of Global Configuration. 

•	 SAP R/3 Admin Local - The SAP R/3 Admin Local group includes tools for editing and 
distributing files for local configuration. 

•	 SAP R/3 NT - Tools for Windows managed nodes. These are only a subset of the Tools 
available for UNIX nodes. 

•	 SAP R/3 UN*X - Tools for UNIX managed nodes. Some tools are also available for 
Windows nodes. 

For more information on tools, see Using SPI for SAP Tools on page 61 

Policies 

SPI for SAP consists of policies that monitor the SAP systems. The policies contain settings 
that enable incoming data to be measured against predefined rules. These rules generate 
useful information in the form of messages. The messages have color-coding to indicate the 
severity level. You can review these messages to analyze and resolve the problem. There are 
several pre-defined corrective actions for specific events or threshold violations. These 
corrective actions can be triggered automatically or operator-initiated. Monitoring comprises 
of generating alarms related to critical events of the tool, and logging important performance 
metrics of the application server. 

The SPI for SAP creates the following policy groups/sub groups and configuration files under 
the en folder. 

•	 SAP NW Java Monitoring 7.0 

•	 SAP NW Java Monitoring 7.1 

•	 SAP R3 6.x 7.0AS 7.1kernel 

•	 SAP R3 6.xCI 

• SAP R3 7.0CI 7.1kernel 

For more information on policies, see Customizing SPI for SAP Policies on page 71 
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Reports 

SPI for SAP reports are web-based reports that are produced by HP Reporter (Reporter) using 
the default templates and viewed using a web browser. You can request both scheduled and 
on-demand versions of reports using Reporter. 

SPI for SAP service reports correlate the data extracted from either the HP Software 
Embedded Performance Component (CODA) or the HP Performance Agent. You can use the 
correlated data to generate reports which display short-, medium-, or long-term views of your 
IT environment and supplement the detailed, real-time graphs that the Performance 
Manager provides. You can use these reports for trend analysis. For more information on 
Reports, see Integrating the SPI for SAP with HP Reporter on page 109. 

Functions of the SPI for SAP 

The SPI for SAP provides you with a centralized problem-management environment with HP 
Operations agents on SAP NetWeaver managed nodes. The use of the central HP Operations 
management server avoids the duplication of administrative effort. 

Server Performance and Availability Information 

Availability management alerts you when something in your SAP NetWeaver environment is 
going wrong, for example: a disk is full or a key process has either stopped prematurely or 
failed to start at an appropriate time. The combination of the SPI for SAP and HPOM alerts 
SAP administrators about such conditions and provides the following additional assistance in 
the alert message: 

• Advice about corrective action that should be taken 

• A pre-defined action that the administrator can initiate.


An automatic action, such as an e-mail message to a manager if a critical condition occurs.


Displaying Information 

The SPI for SAP policies generate messages when a threshold is exceeded. These messages 
can appear as: 

Messages in the Message Browser– HP Operations Agent software compares the values 
gathered for the performance and availability of SAP against the monitor policy related to 
those specific areas. The agent software then forwards appropriate messages to the HPOM 
console. These messages appear with color-coded severity levels in the HPOM message 
browser. 

Instruction Text– Messages generated by the SPI for SAP programs contain instruction text 
to help analyze and solve problems. You can perform corrective actions preassigned to events 
or they can be triggered automatically. 

Instruction text is present in the Message Properties window. To view the text, right-click the 
message, select Properties, and chose the Instructions tab. 
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Metric Reports– In addition to the instruction text, some messages cause automatic action 
reports to be generated. These reports show conditions of a specific SAP instance. If a report is 
available, you can view it by clicking the Annotations tab in the Message Properties window. 

Generating Reports using HP Reporter 

You can integrate the SPI for SAP with HP Reporter to provide you with management-ready, 
web-based reports. The SPI for SAP Report package includes the policies for generating these 
reports. You can install the Report package on the Reporter Windows system. 

After you install the product and complete basic configuration, by default, Reporter generates 
reports of summarized, consolidated data every night. You can use these reports to assess the 
performance of the system over a period of time. 

Customizing Policies and Metrics 

You can use the SPI for SAP policies without customization, or modify them to suit the needs 
of your environment. Some of the modification and customization that you can do are the 
following: 

•	 Modify the default policies - Within a policy, you can change the default settings for: 

—	 Collection interval 

—	 Threshold 

—	  Message text 

—	 Duration 

—	  Severity level of the condition 

—	 Actions assigned to the condition (operator-initiated or automatic) 

•	 Create custom policy groups – You can create custom policy groups using default policies 
as base. For more information, see Customizing SPI for SAP Policies on page 71. 

•	 Create custom metrics– You can define your own metrics or User Defined Metrics (UDMs) 
to expand the monitoring capabilities of the SPI for SAP. For more information about 
UDMs see the HP Operations Smart Plug-in for User Defined Metrics User Guide. 
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2 Installing the SPI for SAP

This chapter provides the information you need to check the suitability of your systems for the 
installation of the Smart Plug-in for SAP. For instructions on installing the SPI for SAP R/3 
Performance Agent, see the HP Operations Smart Plug-in for SAP Reference Guide 

Installation Packages 

The following are the SPI for SAP packages available in the HP Operations Smart Plug-ins 
DVD. 

SPI Package 

The HP Operations Smart Plug-ins DVD for HPOM for Linux contains the following 
packages: <SPI DVD>\Linux\HP_Operations_Smart_Plug-ins_Linux_setup.bin 

Reporter Package 

The Reporter package contains the reports provided by the SPI. The Reporter gathers the 
data from the nodes managed by the SPI through HPOM, stores the data in its local database, 
and creates reports based on the default SPI report policies. The SPI for SAP reporter 
packages are available at the following location on the media: 

<SPI_DVD>\WINDOWS\OV_REPORTER\SAPSPI_REPORTER\sapspi_reporter.msi 
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Installation Overview 

The following flowchart summarizes the steps for installing and configuring the SPI for SAP. 

Installation Prerequisites 

Before starting to install or upgrade the SPI for SAP, you must perform the following tasks: 

•	 Make sure that your system meets the requirements detailed in the following sections: 

—	 System Requirements on page 15 

—	 Compatible Software Versions on page 17 

•	 For each SAP instance, note the following: 

—	 Which SAP version is installed? 

—	 Is SAP installed on a central instance or an application server? 

•	 Create a list of all the SAP clients (ABAP stack) to monitor. For each client, list the 
following data: 
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—	 User ID and password 

—	 Hostname of the SAP application server 

—	 SAP system ID 

—	 SAP Instance number 

—	 SAP client number 

—	 Operating system platform (UNIX or Microsoft Windows) 

•	 Create a list of all SAP clients (Java stack) to monitor. For each client, list the following 
data: 

—	 User ID and password 

—	 Hostname of the SAP application server 

—	 SAP system ID 

—	 SAP instance number 

—	 Cluster node ID 

— Operating system platform (UNIX or Microsoft Windows)


You will use this information to set up the environment configuration file for the SPI for 

SAP. 

For more information, see the HP Operations Smart Plug-in for SAP Reference Guide. 

Hardware Requirements 

See the HP Operations Manager for UNIX Installation Guide for information on hardware 
requirements. 

System Requirements 

Before you install or upgrade the SPI for SAP, use the information provided in Table 1 to 
ensure that your systems (management server and managed nodes) meet hardware, 
operating system, and disk space requirements. 

Table 1 lists the disk space requirements for both the management server and the managed 
node. 
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Table 1 Disk Space Requirements 

Product Version 
Minimum Disk 

Space 

SPI for SAP on the management server 9.00 1.4 GB a 

SPI for SAP on managed nodes Approximately 40 
MB. b The 
disk-space 
requirement on the 
node will increase 
with the amount of 
data collected and 
logged by the SPI. 

SPI for SAP Reporter Package 1 GB 

a. 300 MB for installation, 600MB for configuration, 200MB for uncompress action after 
first distribution 

b. Depends on the operation system installed 

Table 2 lists the versions of HPOM for Linux versions supported with this version of the SPI 
for SAP. 

Table 2 Supported HPOM Management-Server Platforms 

Product Version Operating System Platform 

HPOM for 9.0x Linux 
Linux 

Table 3 shows which combinations of the SAP NetWeaver kernel and (in brackets) the SAP 
NetWeaver Basis version are supported by the SPI for SAP and, in addition, on which HPOM 
managed-node platforms the combination must be running. The third column of Table 3 
reflects a change to the SAP NetWeaver version-numbering system and shows the SAP 
NetWeaver basis version and (in brackets) the SAP NetWeaver kernel version. 

Table 3 Managed Node Platforms and SAP Kernel Versions 

SAP NetWeaver Basis (Kernel) 
Managed 

7.0 Node 
Operating 6.40 (7.0)a 

System 7.1 (7.1) (6.40) 

✓ ✓ ✓AIX b 

HP-UX ✓ ✓ ✓ 

Linux ✓ ✓ ✓ 

Solaris ✓ ✓ ✓ 

Windows ✓ ✓ ✓ 
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a.	 Due to changes in SAP, the operation-mode monitor r3monoms is 

not supported.


b.	 64-bit OS runtime only 

The SPI for SAP supports additional SAP application components, for example; BBP 
(Business-to-Business Procurement) and BW (Business Warehouse), only if the application 
component is compatible with one of the combinations of SAP NetWeaver Kernel/Basis 
versions specified in Table 3. The SPI for SAP does not support specific SAP 
technology-components. 

You must install the latest version of the Microsoft .NET framework on all the Windows 
managed nodes. 

Compatible Software Versions 

Before you install or upgrade the SPI for SAP, use the information provided in this section to 
ensure that the installation or upgrade process proceeds without problems. For example, note 
the following important points: 

•	 Use Table 2 to check that you are using a version of HPOM that is compatible with the 
current version of the SPI for SAP. 

•	 Are both the HPOM server software and the HPOM agent software installed on the 
HPOM management server? 

•	 Are the standard, HPOM, management-server templates assigned and distributed to the 
HPOM management server? 

•	 Is HP Reporter available to view service reports for SAP NetWeaver, SAP NetWeaver 
performance data? 

If you want to edit existing (or create new) Service Reports for the SPI for SAP, Crystal 
Reports version 9 must be running on the machine hosting the HP Reporter 3.80 (or 
higher). 

•	 For Performance Agent functionality (see also the 

—	 HP Performance Manager must be available if you want to use performance graphing 

—	 HP Performance Agent software must be installed on all the SAP application servers 
you wish to monitor 

The HP Operations Smart Plug-in’s DSI-to-DDF wrapper utilities must be installed 
and running on the HPOM management server. You can check using the command; 
swlist DSI2DDF


# DSI2DDF  2.40.110    HP Operations DSI2DDF 


Note that the SPI for SAP currently works with DSI2DDF version 02.40 on supported 
version of Linux management server. 

Table 2 lists which versions of the HPOM management server software the SPI for SAP 
supports. 

For information about the versions of other related software that is supported by the SPI for 
SAP, see the HP Operations Smart Plug-in for SAP Software Release Notes. 
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Installing the SPI for SAP Software 

You can follow the instructions given below to install the SPI for SAP software. 

Support Information: Detailed information on supported operating systems is available in 
the Support metrics available at http://support.openview.hp.com/selfsolve/document/ 
KM323488. 

To install the SPI for SAP on a Linux management server, perform any of the following 
procedure: 

•	 Installing the SPI for SAP through Graphical User Interface 

•	 Installing the SPI for SAP through Command Line Interface 

Installing the SPI for SAP through Graphical User Interface 

To install the SPI for SAP using X-Windows client software, perform the following steps:


1 Login as a root user.


2 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Linux 

management server. Mount the DVD if necessary. 

3	 Start the X-windows client software and export the DISPLAY variable by typing the 
following command: 

export DISPLAY=<ip address>:0.0 

4	 To start the installation, type the following command: 

./HP_Operations_Smart_Plug-ins_Linux_setup.bin 

The Introduction(Install) window opens. 

5 Click Next. The License Agreement window opens. 

6 Select I accept the terms of the License Agreement radio button and click Next. The Select 
Features window open. 
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7 Select the HP Operations Pkg for SPISAP and click Next. By default, the HP Operations 
Smart Plug-ins Component is selected. 

8	 Click Install. 

While installing, you might see the Force reinstallation of already installed component 
packages check box. You can use either of the following options: 

—	 Select the Force reinstallation of already installed component packages check box to 
reinstall the selected components, as applicable. 

—	 Clear the Force reinstallation of already installed component packages check box to 
prevent reinstallation of the selected HP Software components, as applicable. 
Clearing the checkbox does not change the currently installed software components. 

If the installation fails, you can quit installation. Clicking Quit stops the installation, but does 
not uninstall the components installed till then. 

The Installing window opens. The Install Complete window opens once the SPI is uninstalled. 

9	 Click Done to complete the installation. 

Installing the SPI for SAP through Command Line Interface 

To install the SPI for SAP through command line interface, perform either of the following: 

1 Login as root user. 

2 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Linux 
management server. Mount the DVD if necessary. 

3 To start the installation, type the following command: 

./HP_Operations_Smart_Plug-ins_Linux_setup.bin -i console 

4 Click Enter to continue. 
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When the prompt, ‘I accept the terms of the License Agreement’ for the License 
information appears, type ‘Y’ to accept the terms and continue installation. 

5 When the prompt, ‘Please select Features’ for the selection of the feature appears, type the 
number corresponding to the feature you want to install. 

6 Click Enter to continue. 

When you have installed a SPI on the Linux management server and want to 
install another SPI on the same server, you have to reselect the previously 
installed SPI along with the required SPI from the Modify option. If you do not 
reselect the previously installed SPI, only the selected SPI is installed and the 
previously installed SPI is removed from the Linux management server. 

When the installation is complete, you will receive a message which states the installation is 
complete. 

Verifying the SPI for SAP Installation 

To verify that the installation of the SPI for SAP completed successfully, follow these steps: 

1	 Launch the HPOM GUI as the HPOM administrator. To launch the console, select 
Integrations → HPOM for Unix Operational UI. 

The User Login dialog box opens. You can log on with the following default administrative 
credentials:


User name: opc_adm


Password: opc_adm


2	 Click Browse → All Node Groups. The All Node Groups window opens. 

Check that the SPI for SAP node group sap is present. The sap node group must be empty 
at this point in time. 

3	 Click Browse → Tool Bank. The Tool Bank window opens. 

Check that the SPI for SAP tool groups—SAP R/3 Admin, SAP R/3 Admin Local, SAP R/ 
3 NT, and SAP R/3 UN*X—are present under the SPI for SAP group. You must also make 
sure that each of the SPI for SAP tool groups contains tools. 

4	 Click Browse → All Message Groups. The All Message Group window opens. 

Check that the SPI for SAP message groups are present. SPI for SAP message groups 
start with R3_, for example; R3_CCMS. 

5	 Click Browse → All User Profiles. The All User Profiles window opens. 

Check that the SPI for SAP User Profiles—SAP Administrator, SAP Backup, SAP 
Database, and SAP Operator—are all present. 

6 Click Browse → All Policy Groups. The All Policy Groups window opens. 

Check that the top-level SPI for SAP policy group SPI for SAP is present in the list of 
policy groups in the left pane and, by clicking it, contains the main SPI for SAP policy 
groups, for example; SAP NW Java Monitoring 7.0, SAP NW Java Monitoring 7.1,
SAP R3 6.x7.0AS7.1kernel, SAP R3 6.xCI, SAP R3 7.0 CI7.1kernel. 
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Selecting the Performance Data Source 

By default, HPOM for UNIX deploys the HP Performance Agent with all HPOM 8.x agents. 
HPOM Smart Plug-ins use the HP Performance Agent as the default source for the 
performance data required for graphing in HP Performance Manager and for reporting with 
the Reporter. Previously installed HP Operations products that use the HP Performance 
Agent will continue to use Performance Agent as the data source. 

The information in this section explains what to do if you are using the Embedded 
Performance Component (also known as CODA) as the data source on the managed node and 
wish to switch to the Performance Agent. You can override the use of the Embedded 
Performance Component by setting up a small text file, nocoda.opt, which changes the data 
source from CODA to the Performance Agent. 

Once configured, the nocoda.opt file must be stored in a specific location on each managed 
node, whose performance-data source you want to change from the Embedded Performance 
Component to Performance Agent. The location of the nocoda.opt file on the managed node 
varies according to the operating system running on the HPOM management server and 
managed node. Table 4 shows the location of the nocoda.opt file on nodes managed by an 
HPOM for UNIX management server. 

Table 4 HPOM 9.x for Linux Management Servers 

Managed Node 
Operating 
System 

AIX 

HP-UX, Linux, 
and Solaris 

Microsoft 

Windows


Location of the nocoda.opt File 

https: /var/opt/OV/conf/dsi2ddf/nocoda.opt 

https: /var/opt/OV/conf/dsi2ddf/nocoda.opt 

https: %OvDataDir%\conf\dsi2ddf\nocoda.opt 

To change the default setting for the data source from the Embedded Performance Component 
to Performance Agent, open the nocoda.opt file in a text editor and manually enter the 
appropriate information using the format and syntax illustrated in An Example of the 
nocoda.opt File. 

1	 To designate Performance Agent as the agent for all data sources, enter the key word ALL 
at the top of the file. 

2	 To designate Performance Agent as the agent for a data source tied to a specific SAP 
NetWeaver instance, include a reference to each instance on a separate line of the 
nocoda.opt file, as shown in An Example of the nocoda.opt File and using the following 
format: 

For... Use the following format... 

SAP R3_<SAP_Hostname>_<SAPSID>_<SAP_Instance_ Number>_ DATA 
NetWeaver: 

3 Restart the HPOM agent on the managed node where the nocoda.opt file has been 
modified 

An Example of the nocoda.opt File 
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------------------------------------------------------------

############################################################

# Add to (or modify) the contents of this file to change the

# data-source from the default CODA to the Performance Agent

############################################################

# All hosts:

# ALL

# SAP R/3 hosts/instances:

R3_ovsdsap_DEV_00_DATA


Installing the SAP GUI on the HPOM Management Server 

In this step, you install the SAP GUI on the HPOM management server using your SAP 
NetWeaver installation DVD; the SAP NetWeaver installation media contains all the 
instructions and information about pre-requisites that you need to perform the installation 
process. You should use the most recent version of the SAP GUI available for your 
environment. Note that most of the operator-initiated actions and applications included in the 
SPI for SAP have to start the SAP GUI. For this reason, a SAP GUI binary must be installed 
on the HPOM management server or the remote console. 

SAP does not support the SAP GUI on HP-UX/Itanium. The SPI for SAP functionality that 
depends on an SAP GUI being installed on the HPOM management server is not available 
when installing the HPOM management server on Itanium. Instructions and pre-requisites 
for installing the Java GUI for SAP may be found on the SAP installation DVD. 

Make sure the SAP GUI on the HPOM server connects to the SAP system with the necessary 
authentication. 

After installing the SAP GUI from your SAP NetWeaver installation media, you need to make 
the location of the SAP GUI binaries known to the SPI for SAP by running the following 
commands as user root on the HPOM management server: 

1 Set the umask. Enter: umask 22 

2 Set up a link to the SAP GUI. Enter: 

ln -s <your_install_path_to_the_SAPGUI>/sapgui \
/opt/OV/lbin/sapspi/sapgui/sapgui 

ln -s <your_install_path_to_the_SAPGUI>/guilogon \ /opt/OV/lbin/
sapspi/sapgui/javaguilogon 

3 Start the SAP GUI using the following command: 

/opt/OV/lbin/sapspi/sapgui/sapgui \
/H/<hostname>/S/<port_nr> 

where <hostname> is the name of the server on which the SAP NetWeaver instance you 
want to connect to is running, and <port_nr> is the port number allocated to the SAP 
process as defined in /etc/services. 

4 Configure your SAP GUI to use the SPI for SAP application Java R/3 Frontend. For 
example, you need to create a platin.ini file in the home directory of the user calling the 
application. The platin.ini file lists the SAP hosts and instances which are available for 
login. Refer to the SAP GUI installation instructions on the SAP NetWeaver installation 
media for more details. 
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Upgrading the SPI for SAP 

The SPI for SAP 12.00 supports HPOM for UNIX 9.x. If you want to upgrade from SPI for 
SAP 11.00 to the current version, perform the following tasks: 

•	 Upgrade the management server from HPOM for UNIX 8.3x to HPOM for UNIX 9.0x 

•	 Migrate SPI for SAP from HPOM for UNIX 8.3x to HPOM for UNIX 9.0x 

•	 Upgrade SPI for SAP 11.00 on HPOM for UNIX 9.0x to SPI for SAP 12.00 

Upgrade the Management Server from HPOM for UNIX 8.3x to HPOM for UNIX 
9.0x 

Read and follow the steps provided in HP Operations Manager for UNIX 9.00 Installation 
Guide for migrating or upgrading HPOM for UNIX 8.x to HPOM for UNIX 9.00. 

Migrate SPI for SAP from HPOM for UNIX 8.3x to HPOM for UNIX 9.0x 

The instrumentation files and other SPI specific data are migrated while migrating or 
upgrading HPOM 8.x server (where SPI for SAP 11.00 is installed) to HPOM 9.0x. Some SPI 
specific data, however, must be migrated manually. 

There are two types of migration: 

•	 Migrating HPOM from one system to another 

•	 Upgrading HPOM on the same system 

Migrating HPOM from One System to Another 

Install the HPOM for UNIX 9.00 on a new system. To perform the migration from one system 
to another, follow these steps: 

1	 After completing migrating HPOM for UNIX 8.xx to HPOM for UNIX 9.0x, create the 
following directories on the target HPOM for UNIX 9.0x server: 

/opt/OV/lbin/sapspi/

/opt/OV/license-agreements/sapspi/

/opt/OV/paperdocs/sapspi/

/var/opt/OV/share/conf/sapspi/


2	 Copy the files present in the folders created in the above step from HPOM for UNIX 8.xx 
to HPOM for UNIX 9.0x server at their respective folders. 

3 Copy the following files from HPOM for UNIX 8.xx to HPOM for UNIX 9.0x server at 
their respective folders. 

Upgrading HPOM on the Same System 

To upgrade HPOM for UNIX 8.x to HPOM for UNIX 9.00 on the same system, follow these 
steps: 

1 After downloading the current HPOM for UNIX 8.x configuration (That is, after 
performing the step “Downloading the current HPOM 8.x configuration” mentioned in 
Chapter 8, Upgrading HPOM to version 9.00, of the HP Operations Manager for UNIX 
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9.00 Installation Guide), copy the contents of the following directories: 

/opt/OV/lbin/sapspi/

/opt/OV/license-agreements/sapspi/

/opt/OV/paperdocs/sapspi/

/var/opt/OV/share/conf/sapspi/


2 Copy the files into respective folders in HPOM for UNIX 9.0x. 

3 Proceed with the rest of the steps for upgrading HPOM for UNIX 8.x to HPOM for UNIX 
9.00 as mentioned in HP Operations Manager for UNIX 9.00 Installation Guide. 

Limitations and Workarounds 

These are the following limitations for the SPI for SAP support on HPOM for UNIX 9.0x: 

•	 You must complete the migration process from HPOM 8.xx to HPOM 9.0x before 
upgrading the SPI for SAP to version 12.00. Once the SPI for SAP 12.00is installed, 
migrating from HPOM 8.xx is not supported. 

•	 Having the SPI for SAP 11.00 (migrated from HPOM 8.xx) and SPI for SAP version 12.00 
(newly installed from SPI DVD 2009) on HPOM 9.0x is an intermediate mode and you 
must move all managed nodes to the SPI for SAP 12.00 as soon as possible. 

•	 If you have multiple SPIs deployed on a managed node, the node can be monitored either 
by SPI DVD 2008 SPIs or SPI DVD 2009 SPIs. Monitoring a node by combination of SPIs 
from SPI DVD 2008 and SPI DVD 2009 is not supported. 

•	 If you have the SPI for SAP 12.00 installed on HPOM 9.0x systems, which also has the 
SPI for SAP 11.00 as well, the following points are true. 

—	 You must configure newly added managed nodes using the SPI for SAP 12.00. 

—	 No configuration is possible on the existing or old managed nodes monitored by the 
SPI for SAP 11.00. 

This is because the SPI for SAP 11.00 configuration tools are overwritten by the SPI for 
SAP 12.00 tools and these tools are incompatible. 

•	 Patches for the SPI for SAP 11.00 must be installed before you start the HPOM migration 
process. Once the SPI for SAP 12.00 is installed, no patches or hot-fixes pertaining to the 
SPI for SAP 11.00 could be installed on the HPOM server. 

•	 To invoke the GUIs related to SPI for SAP 12.00, you must install X-windows client 
software on the machine from which you will launch the HPOM for UNIX 9.0x server 
Operator GUI. 

•	 Installing patches that would be released in the future for the SPI for SAP 11.00 are not 
supported on HPOM for UNIX 9.0x after migration. However, patch can be installed on 
the HPOM for UNIX 8.xx server and migrated to HPOM for UNIX 9.0x environment. 

•	 After migration from HPOM 8.xx to HPOM 9.0x, when you run license reporting tool from 
HPOM 9.0x, errors would be reported. This is an expected behavior. You can ignore the 
error. 
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Upgrade the SPI for SAP 11.00 to SPI for SAP 12.00 on HPOM for UNIX 9.0x 

You can upgrade the SPI for SAP from HPOM for UNIX 8.3x to HPOM for UNIX 9.0x by using 
either of the following: 

•	 HP Operations Smart Plug-in Toolkit 

•	 HPOM for UNIX console 

Upgrading the SPI for SAP from Smart Plug-in Upgrade Toolkit 

The HP Operations Smart Plug-in Upgrade Toolkit (SPI Upgrade Toolkit) helps you upgrade 
HP Operations Smart Plug-ins to a higher version while retaining the customizations done on 
policies. During the SPI for SAP upgrade process, the SPI Upgrade Toolkit enables you to 
store the modifications done on the customer version of policies. For a specific policy, the SPI 
Upgrade Toolkit analyzes and compares three versions—base, customer, and factory. It helps 
you select the settings of the base, customer, or factory version of the policy—depending on 
your requirement. 

To upgrade the SPI for SAP using the SPI Upgrade Toolkit, follow the instructions in the HP 
Operations Smart Plug-in Upgrade Toolkit UNIX User Guide. 

Upgrading the SPI for SAP from HPOM for UNIX Console 

This section describes how to upgrade the SPI for SAP software from a previous version to the 
current version. Once you have upgraded the SPI for SAP software on the HPOM 
management server, you will need to use the information in Verifying the SPI for SAP 
Installation on page 20 to ensure that the software upgrade completed successfully. 

To migrate the SPI for SAP from an older version to the latest version, follow these steps: 

1	 Ensure you have read and understood the requirements in System Requirements on 
page 15 and Compatible Software Versions on page 17. 

2	 Use the opc_backup command to save the complete, current configuration. This enables 
you to restore the configuration in the event that the upgrade is unsuccessful: 

a	 It is recommended but not absolutely necessary that you download all configuration 
data using the HPOM GUI (and the All option) before you back up the HPOM 
installation. You can also use the command opccfgdwn(1m), which downloads all 
configuration data by default. 

You should also consider downloading history messages and audit entries using the 
opchistdwn(1m) and opcauddwn(1m) commands, respectively. 

b	 Exit all running HPOM GUIs. 

c	 Make a full backup of the current installation. Enter: 

/opt/OV/bin/OpC/opc_backup 

When prompted: 

Do you want to use the full or configuration backup?
(f | c) ==> 

Enter: f for a full backup that includes the HPOM binaries and the configuration 
data. 

d	 Make safety copies of any configuration files that contain modifications you made to 
the original configurations. Table 5 shows the directories where configuration files can 
be found. Note that the configuration has changed from the previous SPI for 
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SAP version to the current version, for example; message conditions. In addition, 
although the configuration files from the older version are compatible with the 
current version, the default configuration has changed for some of the monitors. 

It is not recommended to overwrite newly installed configuration files with old 
ones. Rather, you should carefully incorporate into the new configurations files 
any changes that were made to the old configuration files 

Table 5 Locating SPI for SAP Configuration Files 

Configuration 
Files 

Originals a 

Global b 

Local 

Directory Location 

/opt/OV/newconfig/var/opt/OV/share/conf/sapspi


/var/opt/OV/share/conf/sapspi/global


/var/opt/OV/share/conf/sapspi/local


a.	 Originals: placed here during installation of the SPI for SAP software. Note 
that older versions of the SPI for SAP installed the configuration files to: / 
opt/hpitosap/config/[cmds|monitors], a directory which is not removed 
as part of the upgrade to 11.00. 

b.	 Working copies of the originals, which are placed here during configuration of 
the SPI for SAP. 

3	 If you have modified any of the SPI for SAP policy groups, create a safety copy of the SPI 
for SAP policy group and all the policies it contains. For instructions concerning how to 
copy policies, refer to the HP Operations Smart Plug-in for SAP Reference Guide. 

You cannot simply overwrite the new policies delivered as part of SPI for SAP 
version 12.00 with the backup copy of the previous policy version. You have to 
merge any changes you made to the old policies into the new policies. Since some 
of the new policies have been revised and improved, overwriting them with an 
older version will result in unmatched messages. 

4	 If you are using the SPI for SAP performance-monitor sub-agent version 11.00, please 
read the section about upgrading the SPI for SAP R/3 Performance Agent in the HP 
Operations Smart Plug-in for SAP Reference Guide before continuing with the next step, 
which concerns the removal of the old SPI for SAP software. 

You need to remove the old SPI for SAP performance monitor subagent before you 
remove and upgrade the SPI for SAP. 

5	 Remove the old SPI for SAP software from the management server and the managed 
nodes: 

a	 Remove the SPI for SAP components and the agent software from the managed nodes 
using the HPOM GUI. 

b	 Remove the SPI for SAP performance-monitor sub-agent components from the 
managed nodes using the HPOM GUI. 

6 Remove the old SPI for SAP software from the management server and the managed 
nodes: 

a	 Do not, even if prompted, delete any HPOM UI-integration elements: most elements 
remain unchanged between the previous and current versions of the SPI for SAP. 
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b	 Before removing the existing SPI for SAP software from the HPOM management 
server, remember to run the command r3itoins -u, which removes the SPI for SAP 
binaries from the HPOM database. The following message is displayed: 

Removing SPI for SAP instrumentation from OVO instrumentation directory
tree. 

c Use the swremove(1M) command to remove the SPI for SAP software from the 
management server. On the management server, as user root, enter: 

swremove SAPSPI 

7 Install and configure the new SPI for SAP software according to the instructions provided 
in Installing the SPI for SAP Software on page 18. 

Answer “No” when SPI for SAP’s r3itoins script asks whether to overwrite the existing 
version of the configuration-file with the new SPI for SAP factory defaults, as follows: 

A set of SPI for SAP configuration files is already in use. Uploading the 
factory defaults now will overwrite the configuration files already in
use. Overwrite the existing configuration files with the factory defaults? 
<y,n> No 

8	 HPOM provides a number of tools to help you cross check duplications and changes, which 
result from the upgrade. For example the opcdbidx command checks for any duplication 
of applications. For information about what tools are available with HPOM to help you 
merge old and new configurations after the upgrade, see the upgrade section in the HP 
Operations Manager for UNIX Installation Guide for the Management Server. 

9	 Upgrade the SPI for SAP R/3 Performance Agent. 

Read carefully the instructions in the section about upgrading the SPI for SAP R/3 
Performance Agent in the HP Operations Smart Plug-in for SAP Reference Guide before 
converting any data. 

10	 To remove the old directory structure, enter: 

rm -r /opt/hpitosap 

When you upgrade SPI for SAP from a previous version to the 12.00 version, you 
must deploy the instrumentation and deploy all the configuration files except 
r3itosap.cfg file. You must then deploy the scheduled policies. 
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Downloading SAP Libraries 

You must download the necessary SAP RFC libraries on the management server. To download 
the SAP RFC libraries, follow these steps: 

1 Create the following directory on the management server: 

sapRFCLibSrc=/tmp/Sap_RFC_Downloads/Libraries 

2 Inside the newly created Libraries directory, create the following directory structure: 

a Create the Libraries directory under the /tmp/Sap_RFC_Downloads directory. 

b Under the Libraries directory, create the Windows, Linux, Sun, HPUX, and Aix 
directories.


c Under the Windows directory, create the 32bit and x64 directories.


d Under the Linux directory, create the x64 and ipf64 directories.


e Under the Sun directory, create the sparc directory.


f Under the Aix directory, create the x64 directory.


g Under the HPUX directory, create the IPF64 and PA directories.


3	 Download the appropriate flavors of the RFC SDK 6.40 from the SAP Software 
Distribution Center website (http://service.sap.com/swdc). 

Regardless of the version of SAP deployed in your environment, always download 
the RFC SDK version 6.40. 

Extract the contents of the RFC SDK and copy the library files into the directories created 
in step 2 as listed in the following table: 

Table 6 SAP Libraries 

Node Platform Library File Copy into the Folder 

Windows 32-bit librfc32.dll /Windows/32bit 

Windows X64 librfc32.dll /Windows/x64 

Linux librfccm.so /Linux 
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Table 6 SAP Libraries 

Node Platform Library File Copy into the Folder 

Linux librfccm.so /Linux/x64 

Linux librfccm.so /Linux/ipf64 

Solaris librfccm.so /Sun/sparc 

HP-UX IA-64 64-bit librfccm.so /HPUX/IPF64 

HP-UX PA-RISC librfccm.sl /HPUX/PA 

Aix a librfccm.so /AIX/x64 

a.	 For all supported flavors of AIX, use the AIX 64-bit RFC SDK (6.40). 

4	 After placing the library files into the newly created directories, run the Install the RFC 
Library application on the management server from the SPI for SAP > SAP R/3 Admin tool 
group. 
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3 Configuring SAP-Specific Tasks

This chapter provides the information you need to configure SAP NetWeaver to recognize and 
work with the Smart Plug-in for SAP. 

Customization in SAP 

•	 Enable or disable SAP NetWeaver client groups so that these are tracked or not tracked in 
the CCMS alert monitor. This method is discussed in the HP Operations Smart Plug-in for 
SAP Reference Guide. 

—	 Enabled messages cause a CCMS alert to be created, which can then be identified by 
the SPI for SAP CCMS alert monitor and forwarded to the HPOM management 
server. 

—	 If a message is disabled in the CCMS alert monitor, there will be no internal SAP 
NetWeaver CCMS alert, so there will also be no message. 

•	 Set thresholds for the inclusion of alert messages in the SAP NetWeaver CCMS alert 
monitor. This method is discussed in the HP Operations Smart Plug-in for SAP Reference 
Guide. 

•	 Set up selected alert messages so that they are included in the SAP NetWeaver system log 
file. This method is discussed in the HP Operations Smart Plug-in for SAP Reference 
Guide. 

In this Section 

The tasks in this phase require knowledge of SAP transactions and specific monitoring 
requirements. You will be working with the HPOM GUI as well as on the SAP system 
application servers. You will need to log in to HPOM as an operator and to the SAP clients as 
a user with sufficient authority to perform the SAP tasks included in this phase. These tasks 
are summarized as follows: 

1	 Applying the SAP Transport on page 32. 

In this step, you copy the SPI for SAP transport files to the SAP transport directories on 
each SAP NetWeaver central instance and apply them. These files are placed temporarily 
in the HPOM directory to facilitate the HPOM administrator task of distribution of SPI 
for SAP components to SAP nodes. 

2 Setting Up an SAP User for HPOM on page 35. 

This is necessary so that the SPI for SAP can log on to SAP whenever SPI for SAP 
applications, monitors, or actions need access to SAP. 
31 



3 Configuration Values for SPI for SAP Monitors on page 37. For more information, see the 
HP Operations Smart Plug-in for SAP Reference Guide. 

After you have set up and distributed the configuration values, the SPI policies 
must be distributed to the SAP nodes. See Configuring HPOM Administration 
Tasks on page 41. 

4 Modifying Configuration-File Templates on page 38. 

The SPI for SAP validates the contents of r3moncol-based configuration files when you 
attempt to save them and will not allow you to save a file that contains a configuration 
error. 

Applying the SAP Transport 

In this step, you copy the transport files that are delivered with the SPI for SAP to the SAP 
transport directories on each SAP central instance. The transport that you import in this step 
contains SAP roles and authorization profiles, which are required to complete the 
configuration of the SAP user later in this section. 

The SPI for SAP provides transports for supported SAP versions that include SPI for SAP 
functionality in the SAP name space "/HPOV/". As a result of this naming convention, 
administrators now must use the new SPI for SAP name-space transports if they want to use 
the SPI for SAP to monitor SAP Systems. 

It is possible to import the new SPI for SAP name-space transport into an SAP System where 
previous versions of SPI for SAP transports already exist. 

The SPI for SAP includes the following transport files: 

• R3Trans.car 

The R3Trans.car transport contains all the ABAP monitors that the SPI for SAP uses 
along with the default configuration settings; you import the R3Trans.car transport into 
the SAP’s central monitoring system (CEN) which monitors all the satellite systems 
connected to it through the r3monal monitor. 

• SAPSPI_CCMS_Monitors.car 

The SAPSPI_CCMS_Monitors.car transport adds the SPI for SAP’s CCMS-based 
monitors for J2EE, System security, standalone-enqueue servers, the Enterprise-Portal, 
and XI monitoring to the CCMS monitor set HP OV SAP-SPI. You import the 
SAPSPI_CCMS_Monitors.car transport either into the individual SAP systems whose 
CCMS alerts you want to monitor with the SPI for SAP or, if configured, into the central 
monitoring system (CEN). In SAP terms, the CEN is the system you configure as the 
central management point of control for any CCMS alerts originating from anywhere in 
the monitored SAP landscape. 

The naming conventions used for the transport objects are as follows: 

Objects in SPI for SAP 

Development Class: /HPOV/SAPSPI


Function Groups:	 /HPOV/ZLPO

/HPOV/ZSPA

/HPOV/ZSPB
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/HPOV/ZSPY
/HPOV/WEBAS
/HPOV/WEBAS70
/HPOV/SOLMAN 

Function modules: /HPOV/OV_* 

Programs: /HPOV/YSPI*
/HPOV/ZHPSPI* 

Roles: 
Roles: 

/HPOV/SAPSPI_MONITORING* 
/HPOV/SAPSPI_SECURITY_MON 

The following procedure requires the CAR/SAPCAR command, which you can find on the SAP 

Kernel CD. 


To copy the SPI for SAP transport files to the managed nodes, follow these steps:


1 In the HPOM All Tool Groups window, open the SPI for SAP > SAP R/3 Admin tool group.


2 Select one or more SAP nodes. 

3 In the SAP R/3 Admin tool group, click the Move SAP Transport icon. A message appears 
in the message browser indicating that the transport has been moved to the specified 
directory. 

The copy operation fails if the operating-system user executing the Move SAP 
Transport application does not have write permission in the transport directory 
(/usr/sap/trans) on the managed node (SAP server). Either enable write access 
to the transport directory or copy the files manually. 

4 As an SAP administrator (<SID>adm) on the HPOM managed node, use the CAR (or 
SAPCAR) command to unpack the transport files to /usr/sap/trans. Enter: 
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CAR -xvf R3Trans.car 

The SPI for SAP transport package contains a number of different transport files, for 
example: the main SPI for SAP transport, test programs, user-roles, and special localized 
text symbols. Some transports are mandatory; some are optional. Which transports you 
need to import depends on the version of SAP running in the System you want to monitor 
with the SPI for SAP. For more information about the SPI for SAP transports, their 
contents, and whether they are mandatory, see the transport read-me file on the 
management server: /usr/sap/trans/readme. 

5 You can import the SPI for SAP transport either by using command line or SAP GUI. 

To import SPI for SAP transport using command prompt, follow these steps: 

Import the SPI for SAP-related transport to your SAP application servers. Enter the 
following commands as SAP administrator (<SID>adm) on the managed node: 

cd /usr/sap/trans/bin

tp addtobuffer <transport_file_name> <SID> 

tp import <transport_file_name> <SID> client=<client_ number>


Where the <SID> is the SAP System ID on the HPOM managed node and 
<transport_file_name> is the name of the transport file, which corresponds to the 
version of SAP NetWeaver running on the HPOM managed node. For example: 

tp addtobuffer SPIK900132 CIA 

The transport file name, SPIK900132, and the SAP System ID, CIA, are used here only to 
illustrate the correct syntax for the tp command. For more information about transport 
numbers and SAP NetWeaver versions, see the following file on the HPOM management 
server after installation of the SPI for SAP bits: /opt/OV/lbin/sapspi/trans/readme. 

If, when running the tp addtobuffer or tp import commands with versions of SAP 
NetWeaver up to and including SAP 4.5, the tp command indicates that it cannot find 
files or required information, you can use the pf=<path>/TPPARAM option to show the 
location of the tp-parameters file: 

pf=/usr/sap/trans/bin/TPPARAM 

The TPPARAM file contains the configuration parameters, which the tp command uses. 
The configuration parameters include such things as the SAPSID, the database 
hostname, and the database configuration paths. Note that, from SAP 4.6 onwards, the 
name and format of the TPPARAM file has been changed as follows: 

pf=/usr/sap/trans/bin/TP_DOMAIN_<SID>.PFL 

If you encounter errors when using the tp addtobuffer command, you can clean the tp 
buffer using the following command: 

tp cleanbuffer <SID> 

Alternatively, you can import transport files using the SAP GUI. To import transport files 
using the SAP GUI, follow these steps: 

a	 Log on to all SAP Systems where you want to apply the SPI for SAP transport file. 

Transports must be applied to each SAP System. 

b	 In the SAP GUI, enter the following transaction ID to display the SAP Transport 
Management System (SMTS) login page: STMS 

c In the SAP Transport Management System login page, click the Transport icon (or 
press the F5 function key). 
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d Select the SID of the SAP System into which you want to import the SPI for SAP 
transport. 

e In the file menu, click Extras > Other requests > Add. 

f In the Transport-Request-to-Import queue, enter the following: 

<Transport_file_name> 

A readme file lists the SPI for SAP transport file names; you can find the readme file 
on the HPOM management server in the following location: 

%OvShareDir%\Packages\SAPTransports 

You must import the SPI for SAP user role into the client where you created the 
SAP user "ITOUSER". For more information, see Setting Up an SAP User for 
HPOM on page 35. The default client for the SPI for SAP user-role transport is 099. 

g Select the Check [✓] icon or use the Enter key to add transaction requests. 

h Highlight the desired transport. 

If you do not select any transport, SAP assumes you want to select all transports in 
the list. 

i Select Request > Import. The Import Request dialog box opens. 

j Enter the target client number (000 is the default client number). 

k Check items in the Option tab that are appropriate for your system. 

l Click the Check [✓] icon or press Enter. 

6 Repeat this procedure for each SAP System you want to manage with HPOM. 

Setting Up an SAP User for HPOM 

For every SAP SID where you want to allow the automated log on of HPOM operators:


1 Log on to SAP.


2 Call the following transaction: /nsu01


3 Create a new user named ITOUSER using the parameters specified in the following list:


Since user-role transports are client dependent, the SAP user "ITOUSER" must be 
created in the same SAP client as the import client of the SPI for SAP user-role 
transport. Otherwise it is not possible to assign user role "/hpov/ 
sapspi_monitoring*" to the new "ITOUSER". 
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User Type	 DIALOG 

If you do not set the User type to DIALOG and do not define a 
corresponding password, the SAP GUI will not work and many of the 
operator-initiated actions and applications within HPOM will be 
unavailable. However, performance and event monitoring do work with 
the CPIC/SYSTEM user. 

Initial 	 any SAP-allowed value except HPSAP_30 
password	 The password HPSAP_30 is associated with the use of the =default value 

in the SPI for SAP’s central, monitor-configuration file, r3itosap.cfg. If 
you intend to use the =default value, you cannot enter HPSAP_30 now as 
you will need it when you first log in to SAP (as ITOUSER) after 
completing setup, and SAP prompts you to set ITOUSER’s password. 

User Roles	 SAP User Roles need to be defined from SAP version 4.6C onwards. Use 
transaction /nsu01, as shown in Figure 1 on page 37. Note that 
ITOUSER requires authorizations to be able to execute SPI for SAP 
ABAP functions. Select the following user role: 

• /HPOV/SAPSPI_MONITORING_TCODE 

This user role enables the use of certain SAP transactions and does 
not place any restrictions on the SPI for SAP functionality. 

• /HPOV/SAPSPI_MONITORING_NO_TCD 

This user role does not contain any SAP transaction authorizations 
(NO_TCD) and restricts the SPI for SAP functionality by preventing 
the SAP user from starting SPI for SAP applications or 
operator-initiated actions. The SAP user can, however, still logon to 
SAP. 

• /HPOV/SAPSPI_SECURITY_MON 

If you plan to use the r3monsec monitor to monitor SAP System 
security, you must also assign to ITOUSER (or the user under which 
r3monsec runs) the authorizations defined in /HPOV/ 
SAPSPI_SECURITY_MON, the SPI for SAP-security user role 

4	 Activate the profile and assign it to the SAP user “ITOUSER”, which you have already 
created. 

When assigning SPI for SAP roles, it is important to verify that all required authorization 
objects are active and the user comparison completed successfully. SAP uses the color 
green to indicate that user-authorization objects are active or that user comparisons 
completed successfully; the color red indicates that you need to activate 
user-authorization objects or complete a user comparison. Transaction SU01 displays 
details of SAP user roles. 

5 Log on to SAP as user ITOUSER. 

6 SAP NetWeaver prompts you to change the password initially specified for ITOUSER. If 
you have not specified your own SAP user logins and intend to make use of the =default 
value in the SPI for SAP’s central, monitor-configuration file r3itosap.cfg, enter the 
following, new password: HPSAP_30 
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Figure 1 SAP User Roles for ITOUSER 

Configuration Values for SPI for SAP Monitors 

To conclude the SAP-specific tasks, you have to set up initial configuration values for the SPI 
for SAP monitors before you distribute the configuration files to the managed nodes. Note that 
this step requires detailed and expert knowledge of SAP and the SAP Systems, which you 
intend to monitor with the SPI for SAP. For example, when setting up the r3monale monitor 
to check the status of incoming and outgoing iDOCs, you need to understand the iDOC system 
to be able to decide what information is important and how you want the SPI for SAP to 
monitor it. The SPI for SAP includes the monitors listed in Table 7. 

Table 7 SPI for SAP Monitors 

Monitor Name 

r3monaco


r3monale


r3monal


r3monchg


r3moncts


r3mondev


r3mondisp


r3mondmp


r3monjob


r3monlck


Description 

Alert collector for TemSe calls 

iDOC status monitor 

CCMS monitor 

System change monitor 

Correction and Transport system monitor 

Trace monitor of the SAP logfile: 
<SID>/<INSTANCE>/work/dev*


ABAP dispatcher monitor 

ABAP/4 Dump monitor 

Job monitor 

Lock check monitor 
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Table 7 SPI for SAP Monitors (cont’d) 

Monitor Name 

r3monoms a 

r3monpro


r3monrfc


r3monsec


r3monspl


r3status


r3montra


r3monupd


r3monusr


r3monwpa


Description 

Operation mode switch monitor 

Operating system process monitor 

SAP RFC-destination monitor 

SAP-security monitor 

Spool monitor 

SAP NetWeaver status monitor 

Transport monitor 

Update monitor 

User monitor 

Work-process availability monitor 

a.	 Due to changes in SAP, the operation-mode monitor r3monoms is not 
supported with SAP NetWeaver 04/WebAS 07. 

The SPI for SAP provides two sets of applications to help you configure and distribute 
monitors: 

•	 Global Applications 

For the configuration of monitors which apply to all managed nodes. For more information 
about which applications open which monitor-configuration files, see The SAP R/3 Admin 
Tool Group on page 61. 

•	 Local Applications 

For the configuration of monitors which apply only to a specified managed node. For more 
information about which applications open which monitor-configuration files, see The 
SAP R/3 Admin Tool Group on page 61. 

For more detailed information about (and instructions for) configuring the SPI for SAP 
monitors and installing Performance Agent agent-related functionality, refer to the HP 
Operations Smart Plug-in for SAP Reference Guide. 

Modifying Configuration-File Templates 

If you use HPOM tools to edit a SPI for SAP monitor-configuration file that uses the r3moncol 
structure, the SPI for SAP automatically validates the contents of the file when you attempt 
to save it and will not allow you to save a file that contains a configuration error. For more 
information about the validation tool and the error messages it generates, refer to the HP 
Operations Smart Plug-in for SAP Reference Guide. 

Figure 2 on page 39 shows the information the SPI for SAP displays if the configuration 
parser discovers that an error exists in the monitor-configuration file when you try to save it. 
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Figure 2 Parsing Monitor-Configuration Files 

After the parsing is complete, the configuration parser indicates that it has found errors and 
explains that you cannot save the file until the errors have been fixed. The message displayed 
at the bottom of the configuration file you are modifying invites you to press Enter to display 
the first error (if more than one error exists) that needs to be fixed. 

If the monitor-configuration file you want to save does not contain any errors, the SPI for SAP 
displays a message similar to the one illustrated in Saving Valid Monitor-Configuration Files 
on page 39, which indicates that the modified configuration file for the SAP iDOC-status 
monitor r3monale is valid and reminds you to activate the new configuration and distribute it 
to the managed nodes. 

Saving Valid Monitor-Configuration Files 

"/var/opt/OV/share/conf/sapspi/global/r3monale.cfg" 62 lines, 2422 characters 

*** parsing configuration file ***

**** parsing completed ****

Use the 'Install Config' application to activate and distribute

the configuration to the managed node(s).

Press <return> to continue
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4 Configuring HPOM Administration Tasks

This chapter provides the information you need to configure HPOM to recognize and work 
with the Smart Plug-in for SAP. 

Customization in HPOM 

•	 Use powerful monitors to tune the control of your distributed SAP NetWeaver 
environment. For details see, the HP Operations Smart Plug-in for SAP Reference Guide. 

•	 Apply filters to display only the relevant types of messages. This method is discussed in 
the HP Operations Smart Plug-in for SAP Reference Guide. 

•	 Change the severity of messages in accordance with your specific requirements. This 
method is discussed in the HP Operations Smart Plug-in for SAP Reference Guide. 

Configuration Prerequisites 

On the HPOM management server, you must complete the following tasks before configuring 
SPI for SAP. 

•	 Assign Operator Responsibilities for opc_adm 

•	 Assign Tools 

Assign Operator Responsibilities 

To assign operator responsibilities, follow these steps: 


1 Log on to HPOM as administrator. For example, as opc_adm.
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2 Select All Users → <Operator_Name>. For example, select the user opc_adm. The User 
opc_adm screen appears. 

3 To change a user’s responsibility, select Edit Responsibilities from the Actions menu. 

Actions 

4 For SPI for SAP message groups, make sure all the check boxes are selected. 

5 Assign the SPI for SAP for appropriate operators. 

6 Click Save. 

Assign Tools to the Operator 

To assign SPI for SAP tools to the operator, follow these steps: 

1 Open the Tool Bank window and select the SPI for SAP tool group. 
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2 Select Assign to User/Profile... from the Choose an action drop-down box and click Submit 

. The Selector window opens. 

3 Click All Profiles. 

4 Select the operator to which you want to assign the profiles. 

5 Click OK. The SPI for SAP tools are assigned to the operator. 
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Configuring the SPI for SAP from the Management Server 

To configure the SPI for SAP from the Management Server, complete the following tasks: 

Add Nodes to the SPI for SAP Node Group 

To assign nodes to SPI for SAP node group, follow these steps: 

1 Open All Node Groups window and select SPI for SAP nodes. 

2 Select Assign Nodes... from the Choose an action drop-down box and click Submit . The 
Selector window appears. 

3 Click All Nodes. 
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4 Select the nodes running SPI for SAP nodes. 

5 Click OK. 

Assigning Categories to the Managed Nodes 

To assign the Categories to the Managed nodes, follow these steps: 

1 Open the Node Bank window and select the managed nodes. 
Configuring HPOM Administration Tasks 45 



2 Select Assign Categories... from the Choose an action drop-down box and click Submit . 

3 Select the required categories. 

4 Click OK. 

Assigning the SPI for SAP Policies to Managed Node 

To assign the SPI for SAP policies to the managed nodes, follow these steps: 

1 Open the Node Bank window and select the managed nodes. 

2 Select Assign Policies/Policy Groups... from the Choose an action drop-down box and click 

Submit . The Selector window appears. 
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3 Click Policy Bank. 

4 Select the SPI for SAP policies.


5 Click OK.


Deploying the SPI for SAP Categories and Policies to Managed Nodes 

To deploy the SPI for SAP categories and policies, follow these steps:


1 Open the Node Bank window and select the managed nodes.


2 Select Deploy Configuration... from the Choose an action drop-down and click Submit . 
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3 Select Distribute Policies and Distribute Instrumentation. 

4 Click OK. 

Launching Discovery 

To launch the SPI for SAP discovery:


1 Select Integrations → HPOM for Unix Operational UI. 
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2 Log on with the default administrative credentials: 
User name: opc_adm 
Password: opc_adm 

The HP Operations Manager for UNIX appears. 

3 Deploy the discovery policies on the managed node. 

4 From the management server, run the following command: 
opcservice -assign <operator> <service>


For example, /usr/bin/opcservice -assign opc_adm SAP_SPI:SAP
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To view the Service Map, click the Services tab in the message browser. Using the Service 
Map, you can find out the application/services that have a problem (if any). The lines in the 
Service Map are color coded to show various levels of severity. For example, red lines show 
that the application has critical problems. 

Specifying SAP Clients to Monitor 

This section describes how to provide HPOM users and applications with automatic access to 
the SAP GUI and, in addition, tell the HPOM monitors which SAP Systems to monitor. The 
SPI for SAP application SAP R/3 GUI allows you to enter all the information that is required 
to complete this task. 

1	 In the HPOM GUI, open the Tool Bank window and locate the SAP R/3 GUI application, 
which you can find in the tool group, SPI for SAP > SAP R/3 Admin. The SAP R/3 GUI 
application opens the r3itosap.cfg configuration file in a text editor so that you can 
enter the required information concerning the SAP Systems you want to monitor with the 
SPI for SAP. Examples entries in the r3itosap.cfg file (commented out by default) 
illustrate the required content and syntax of a configuration line. 

SAP users must be set up for each SAP client and have permission to display and 
maintain CCMS. The list of SAP clients you made in Installation Prerequisites on 
page 14 includes the information you need for each configuration line. For more 
information on how to set up SAP users for HPOM, see Setting Up an SAP User 
for HPOM on page 35. 

2 Using the pattern of the examples in the r3itosap.cfg configuration file, add a 
HostSapAssign entry for each SAP instance, which you want to monitor with the SPI for 
SAP. When adding entries to r3itosap.cfg, keep in mind the following important points: 
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•	 Make sure you use fully qualified host names for all the host names you specify in the 
r3itosap.cfg file. 

•	 The language specified in each HostSapAssign entry determines the language the SPI 
for SAP monitors use when logging in to SAP and must be one of the languages 
currently supported by the SPI for SAP transports, for example: =EN (English) or =JA 
(Japanese). The language you specify here does not affect or determine the language 
used when starting the SAP GUI. 

•	 r3status, the tool the SPI for SAP uses to monitor the status of SAP Systems, does 
not attempt to verify the existence of the SAP Systems specified in r3itosap.cfg. If 
r3status cannot find a named SID, for example: because of a spelling mistake, it 
reports the SID as unavailable. 

•	 In the central, SPI for SAP, monitor-configuration file r3itosap.cfg, the string 
=default is associated with the default ITOUSER password “HPSAP_30”. If you 
intend to make use of your own SAP user logins, you need to replace =default with 
the appropriate user password. As long as you use the SPI for SAP application R/3 
SAP GUI to edit the r3itosap.cfg file, the password is encrypted automatically when 
you save the file. 

Non-ASCII characters are not allowed in SAP-login names or passwords that you 
specify in the r3itosap.cfg file; the SPI for SAP is currently able to resolve only 
ASCII characters in configuration files. 

•	 By default, the SPI for SAP resolves the name of the managed nodes that generate 
messages as the host name defined in the SAP variable, SAPLOCALHOST. 

•	 You must add an entry to the r3itosap.cfg file for each SAP instance running on a 
node that you want to monitor remotely from a managed node. For more information 
about remote monitoring with the SPI for SAP, refer to the HP Operations Smart 
Plug-in for SAP Reference Guide. 

3	 If the hosts you add to the r3itosap.cfg file are configured in a high-availability cluster, 
you need to add an extra entry to the host-mapping section of the r3itosap.cfg file. If 
the hosts you add to the r3itosap.cfg file are not configured in a high-availability 
cluster, you can skip this step and proceed to the next step in the configuration process. 

The information in the host-mapping section of the r3itosap.cfg file maps the names in the 
list of nodes after the third “=” delimiter (typically are the physical nodes in the 
high-availability cluster, and also the name of the node defined in the SAP variable, 
SAPLOCALHOST) to the single node name mentioned after the fourth “?=?”delimiter. This is 
the name of the virtual SAP node, from which the messages from the clustered SAP instance 
appears in the HPOM message browser or the Navigator as from the virtual SAP node. 

The “physical” nodes are the hosts in the high-availability cluster on which you install and 
configure the SPI for SAP. The host names specified in the r3itosap.cfg file must be known 
to HPOM and be resolvable. Whether you choose to use long or short host names depends on 
how you have set up name resolution in your network. 

Short host names are not allowed in the host-mapping section of the 
r3itosap.cfg file. Make sure you use fully qualified host names for all the host 
names you specify for your high-availability cluster in the host-mapping section of 
the r3itosap.cfg file. 

The cluster host-names appear in the HostMapping entry in the form of a 
comma-separated list. The last item in the HostMapping entry defines the name of the 
host with which you want to associate any messages that are generated by nodes in the 
high-availability cluster. For example: 

=ClusterHostA,ClusterHostB,SAPLOCALHOST =<HPOM_Msg_Node> 
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In Mapping physical and relocatable host names, CTO and 11 are the SID and number of 
the SAP instance running in the high-availability cluster. Mapping physical and 
relocatable host names also shows the entry you add to the HostMapping section of the 
r3itosap.cfg file if you want to use the SPI for SAP to monitor a high-availability cluster 
in which the names of the two physical nodes are “True” and “False”, the SAP variable 
SAPLOCALHOST is defined as "maybe", and the name of the host with which to associate 
messages from the cluster is “example”. 

Mapping physical and relocatable host names 

# cluster host mapping

HostMapping =CTO =11 =true.hp,false.hp,maybe.hp =example.hp


In a high-availability cluster, the name of the host with which you associate HPOM 
messages (<HPOM_Msg_Node> in the example above) is usually (but does not have to be) 
the same as the host defined in SAPLOCALHOST. Whether SAPLOCALHOST is (or is 
not) the same as <HPOM_Msg_Node> has an impact on what you need to include in the 
host-mapping section, as follows: 

•	 If SAPLOCALHOST and <HPOM_Msg_Node> are the same host, no entry for 

SAPLOCALHOST is required in the list of cluster nodes, for example:


=ClusterHostA,ClusterHostB =<HPOM_Msg_Node> 

•	 If SAPLOCALHOST and <HPOM_Msg_Node> are not the same host, an entry for 
SAPLOCALHOST is required in the list of physical cluster nodes, for example: 

=ClusterHostA,ClusterHostB,SAPLOCALHOST =<HPOM_Msg_Node> 

All physical nodes in the high-availability cluster must appear in the HPOM Node 
Bank. You also need to add to the HPOM Node Bank as node type "Message 
allowed" the host which you define in <OVO_Msg_Node> in the example above. For 
more information about setting up the SPI for SAP in a high-availability 
environment, see Configuring the SPI for SAP in a High-availability Environment 
on page 88. 

To ensure that automatic or operator-initiated actions are always able to open a SAP GUI 
on the node where the SAP instance is running in the high-availability cluster, you need 
to add a HostSapAssign entry to the r3itosap.cfg file, which specifies the cluster-host 
name defined in the variable HPOM_Msg_Node. 

To avoid problems with HPOM agent settings for host names and IP addresses overriding 
settings defined in the host-mapping section of the SPI for SAP’s central configuration 
file, r3itosap.cfg, which could cause the wrong host name to be displayed in messages 
coming from the cluster, see Host Mapping on Cluster Nodes on page 89. 

4	 Save your changes and exit. 

To ensure that any new passwords you enter in the monitor configuration files are 
encrypted, use the SPI for SAP application R/3 SAP GUI to edit the r3itosap.cfg 
configuration file. If you use a text editor such as vi or emacs to enter passwords in the 
monitor configuration file, any new passwords you enter are not automatically encrypted 
when you save the file and exit. 

Check that the SAP systems have been correctly added by watching the bottom of the 
screen for output similar to Adding SAP SIDs to the r3itosap.cfg File: 
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-------------------------------------------------------------------------
----

Figure 3 Example r3itosap.cfg File 

Adding SAP SIDs to the r3itosap.cfg File 

"/var/opt/OV/share/conf/sapspi/r3itosap.cfg" 15 lines,1175 char
>>> Encoding passwords in file
>>> /var/opt/OV/share/conf/sapspi/r3itosap.cfg started
>>> Encoding of passwords done
>>> Scanning SAP systems for existing front-end done
>>> Symbolic link /usr/sap/SP6/SYS/exe/run -> /opt/OV/lbin/sapspi/sapgui 
created 
>>> Directory /usr/sap/SP6/D0/work created

 In order to activate this configuration, execute "Install Config"
 and distribute the Monitors and Commands to the SAP R/3 managed node 

Press return to continue 

The information in the r3itosap.cfg file is used by the service- discovery application, R/3 
Service Discovery, to generate a service view of your SAP Landscape. If you intend to use 
the Service-Views feature, make sure that you assign and distribute the r3itosap.cfg file to 
the managed nodes for which you want to generate service views before you run the 
service-discovery. The Host mapping entry in the r3itosap.cfg file should have the host 
name details as: 

HostMapping <SID> =<NR> =<system_name>.true.hp.com =<system_name>.hp.com 

where, 

SID - system ID for the server 

NR - the NR number of the server 
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For more information about running service-discovery and setting up service views, see the 
HP Operations Smart Plug-in for SAP Reference Guide. 

Assigning the SAP Servers to the SAP Node Group 

Installing SPI for SAP automatically creates a new node group called sap, to which you assign 
your SAP servers. Note that this step is mandatory; if you do not perform this step, you will 
not see any messages from the SAP servers in the HPOM message browser. 

Before you start adding the nodes, make sure that the latest version of the Microsoft .NET 
framework is installed on all nodes with the Windows operating system. 

1	 In the Node Bank window, select the sap node group. 

2	 Assign all the SAP servers you wish to monitor to the sap node group, following the 
instructions given in Table 8. 

Table 8 Assigning Managed Nodes to Node Groups 

IF... 

the node already exists in 
HPOM node bank 

the node does not already exist 
in the HPOM node bank 

THEN... 

1 Open the Node Bank window. 
2 Select the SAP node. 
3 Select Assign Node to Node Group 

from the Chose an action item 
drop-down and click Submit  . 

4 Select the SAP node group and 
click OK. 

1 Click Edit → Add Node. 

2 Assign the Node to the SAP node 
group. 

3 Install the HPOM agent software 
on the new managed node before 
continuing. 

Assigning SAP Responsibilities 

In HPOM, you can assign operator responsibilities by means of user profiles. The SPI for SAP 
creates four new operator profiles, which may be used as a basis for creating your own SAP 
operators. The four SAP-specific user profiles appear in the All User Profiles window, as 
follows: 

•	 SAP Administrator 

•	 SAP Backup 

•	 SAP Database 

•	 SAP Operator 
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The easiest way to add a new HPOM user is to copy an existing user, change the new user’s 
name, and modify the responsibilities of the new user appropriately. 

1 Open the All Users window. 

2 In the All Users window, click Actions Menu for an existing user, for example opc_op, 
and click the Copy... menu item. The Copy User window appears. 

Change the User Name and Label fields, for example, to: SAP_op and SAP_op 

3 Assign default responsibilities and tools to the new user. Select the Assign Profiles... from 

the Choose an action... drop-down box and click Submit 

4 Click All Profiles and select the appropriate profiles for the new user. 

5 Select Assign Tools... from the Choose an action... drop-down box and click Submit

6 Click Tool Bank and select appropriate tools for the new user.

The responsibilities assigned in a user profile are global and, as a result, not 
immediately visible in the responsibilities matrix of the individual user you create. 
Similarly, the responsibilities of the new user you create are local and only visible 
in the new user’s own responsibilities matrix. However, if you assign the SAP 
Operator user profile to the SAP_op user, all the message and node groups 
included by default in the SAP Operator user profile are indeed assigned to the 
SAP_op user even if it does not initially appear so. 

 To change or modify the responsibilities and applications for any given operator: 

1 In the All Users window, select an existing user, for example SAP_op, and click Edit 
Responsibilities from the Actions menu. The Edit Responsibilities window appears. 

. 

. 
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2 Select the appropriate responsibilities for the selected user. Table 9 lists the standard user 
profiles included with the SPI for SAP and indicates which message groups are assigned 
by default to which SAP operator profiles. 

Table 9 Message-Group Assignments for SPI for SAP User Profiles 

Default SPI for SAP User Profiles 

Message Group SAP SAP SAP SAP 
Admin. Backup Database Operator 

R3 ABAP-4
 ✓ ✓ 

R3 ALE
 ✓ ✓ 

R3_Buffers
 ✓ ✓ 

R3_Backup
 ✓ ✓ 

R3 CCMS
 ✓ ✓ 

R3_CTS
 ✓ 

R3_DB
 ✓ ✓ ✓ ✓ 

R3_Dispatch
 ✓ ✓ 

R3_Enqueue
 ✓ ✓ ✓ 

R3_General
 ✓ ✓ 

R3_Jobs
 ✓ ✓ 

R3_MON_ERROR
 ✓ ✓ 

R3_Performance
 ✓ ✓ 

R3_Roll-Paging
 ✓ ✓ 

R3_RFC
 ✓ ✓ 

R3_Security
 ✓ ✓ 

R3_Spooler
 ✓ ✓ 

R3_State
 ✓ ✓ 

R3_Syslog
 ✓ ✓ ✓ ✓ 

R3_Trace
 ✓ ✓ 

R3_Transport
 ✓ 

R3_Update
 ✓ ✓ ✓ 

R3_User
 ✓ ✓ 

R3_WP
 ✓ ✓ 

R3_XMI
 ✓ ✓ ✓ ✓ 

Click Assign Tools from the Actions menu to modify default tool assignments for an 
existing user. 

3 
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4 Select the tools from the Tool Bank window. 

5 Table 10 lists the standard user profiles included with the SPI for SAP and indicates 
which application groups are assigned by default to which SAP operator profiles. 

Table 10 Tool-Group Assignments for SPI for SAP User Profiles 

Default SPI for SAP User Profiles 

Tool Group SAP SAP SAP SAP 
Admin. Backup Database Operator 

SAP R/3 Admin ✓ 

SAP R/3 Admin Local ✓ 

SAP R/3 NT ✓ ✓ 

SAP R/3 UN*X ✓ ✓ 

6 When you have finished making your modifications, save the changes and click OK. 

Assigning SPI for SAP Policies to SAP Nodes 

The policies for SPI for SAP are organized into default groups, all of which are part of the 
policy group SPI for SAP. The SPI for SAP policy groups are: 

• SAP NW Java Monitoring 7.0 

• SAP NW Java Monitoring 7.1 

• SAP R3 6.x/7.0AS/7.1kernel 

• SAP R3 6.xCI 

• SAP R3 7.0CI/7.1kernel 
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Only one policy group should be assigned to any one managed node. Which policy group you 
assign is determined by the SAP version running on the node and whether the node is a 
central instance or an application server. 

The SPI for SAP’s default policy groups contain policies for all the SAP NetWeaver monitors 
supplied with the SPI for SAP. Assigning and distributing a policy group automatically 
activates the monitors, which the group contains. To avoid receiving messages from 
unnecessary monitors, we recommend you use the default policy groups as a basis to create 
your own policy groups, which contain only those monitors and policies you need. We also 
recommend that you tune the monitors and policies to suit the requirements of your 
environment before assigning and distributing them to the nodes you want to manage with 
the SPI for SAP. This will prevent additional unwanted messages. 

To create your own policy group, copy an existing policy group and modify the contents of the 
new group as follows: 

1 Open the All Policy Groups window, select the policy group you want to copy, and click 

Copy from  Actions menu. The Copy Policy Group window appears. 

2 Enter a name and description for the new policy group and assign the policy group to a 
Parent Group. Click Save to save the changes. 

3 Click the new policy group from the Policy Bank window. 

4 Select the policies and monitors you do not need and remove them using Delete from the 

Chose an action drop-down box and click Submit  . 

5	 In the Node Bank window, select the SAP nodes to which you want to assign the policies. 
Nodes selected together must: 

•	 all run the same SAP version, for example: 6.x 

•	 all have the same usage—application server or central instance 
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6 Select Assign Policies/Policy Groups from the Choose an action drop-down box and click 

Submit . 

7	 Expand the SPI for SAP policy group and select the policy group or groups you have 
created (containing the monitors you need) depending on which SAP version is installed 
on the managed nodes and whether the nodes are central instances or application servers. 
For example: SAP R/3 6.x CI COPY. 

8	 The newly assigned policy is displayed in the Policy Bank list. 

9	 Click OK to assign the policies. 
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5 Using SPI for SAP Tools

The Tool Bank window displays the tools which you can use to manage your SAP NetWeaver 
environment. You can do the following: 

• Start tools 

• Broadcast commands on selected nodes 

Figure 4 The Tool Bank 

SPI for SAP Tool Groups 

The Tool Bank window represents a group of tools. You can click a group to open a 
second-level desktop containing the tools of the group. The following tool groups are added to 
the Tool Bank under the SPI for SAP group when the SPI for SAP is installed: 

• SAP R/3 Admin 

• SAP R/3 Admin Local 

• SAP R/3 NT 

• SAP R/3 UN*X 

The SAP R/3 Admin Tool Group 

The SAP R/3 Admin tool group includes tools for editing and distributing files for global 
configuration, as well as other administrative functions such as moving the SAP transport to 
the SAP transport directories on managed nodes. 
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Figure 5 SAP R/3 Admin Tool Group 

The following table lists the tools which appear in the SAP R/3 Admin tool group and 
describes briefly what each of the tools does. 

Table 11 SAP R/3 Admin Tools 

Tools 

ABAP Dispatcher


ABAP/4 Dump


ALE


Alert Collector


CCMS 4.x


Create SPI SAP Helps you configure the monitoring environment for the SAP 
NetWeaver Config NetWeaver Web Application Server (J2EE) 

CTS Opens the global r3moncts.cfg configuration file 

Delete Config


Install Config


Job


Description 

Opens the global r3mondisp.cfg configuration file for the 
Dispatcher monitor 

Opens the global r3mondmp.cfg configuration file for the 
ABAP-dump monitor 

Opens the global r3monale.cfg configuration file for the 
iDOC-status monitor 

Opens the global r3monaco.cfg configuration file 

Opens the global r3monal.cfg configuration file of the central 
SAP R/3 CCMS alert monitor 

Removes global configuration files from selected managed nodes. 
This should only be used when de-installing the product 

Installs global configurations on selected managed nodes. This is 
the recommended way to distribute monitor-configuration files to 
the managed nodes 

Opens the global r3monjob.cfg configuration file of the job 
monitor 
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Table 11 SAP R/3 Admin Tools 

Tools 

Lock Check


Move SAP Transport


R/3 Service

Discovery


Install Performance Installs performance package on the Windows nodes 
Package (Windows) 

Install Performance Installs Performance package on the UNIX nodes 
Package (UNIX) 

PerfAgt


Remove Performance

Package (Windows)


Remove Performance

Package (UNIX)


Process


R/3 Security 


Check the SAP 

NetWeaver 

Connection


Install the RFC

Library


SAP Availability


SAP R/3 GUI


SAP Trace


SiteConfig


Spool


Statistical Records


System Change


Description 

Opens the global r3monlck.cfg configuration file for the 
lock-check monitor 

Moves the RFC Transport to the directory: /usr/sap/trans. The

OS user starting the tool must have write access to the directory


Automatically creates a service-configuration file that defines a 
service view of the SAP NetWeaver services on the selected 
managed node(s) 

Opens the performance agent’s global configuration file 
r3perfagt.cfg


Removes performance package on the Windows nodes 

Removes performance package on the UNIX nodes 

Opens the process monitor’s global configuration file 
r3monpro.cfg


Opens the SAP security monitor’s global configuration file 
r3monsec.cfg


Checks if a successful connection was established between the SPI 
for SAP and the SAP NetWeaver Web Application Server 

Installs the downloaded RFC libraries into appropriate directories 
on the management server 

Opens the RFC monitor’s global configuration file 

Opens the SAP status monitor’s global configuration file, 
r3status.cfg


Opens the SPI for SAP’s central configuration file r3itosap.cfg 

Opens the SAP trace monitor’s global configuration file 
r3mondev.cfg


Opens the siteconfig file 

Opens the SAP spooler monitor’s global configuration file 
r3monspl.cfg


Opens the performance monitor’s configuration file 
r3perfstat.cfg


Opens the change-system monitor’s global configuration file 
r3monchg.cfg
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Table 11 SAP R/3 Admin Tools 

Tools 

Transport


Update


User


Work Process


Write Statistical 

Records


OM Switch


Description 

Opens the Transport monitor’s global configuration file 
r3montra.cfg


Opens the update monitor’s global configuration file 
r3monupd.cfg


Opens the SAP user monitor’s global configuration file 
r3monusr.cfg


Opens the work-process monitor’s global configuration file 
r3monwpa.cfg


Write statistical records in SAP 

Opens the global r3monoms.cfg configuration file for the 
operation-mode switch monitor 

If you use a SPI for SAP tool to check or modify a configuration file, r3conf uses the text 
editor defined by the environment variable $EDITOR. If the variable $EDITOR is not set, 
r3conf uses vi to edit the SPI for SAP configuration files. For more information about editing 
and distributing monitor configurations, see the HP Operations Smart Plug-in for SAP 
Reference Guide. 

The SAP R/3 Admin Local Tool Group 

The SAP R/3 Admin Local group includes tools for editing and distributing files for local 
configuration. 

Table 12 SAP R/3 Admin Local Tools 

Tools 

Delete Local 

Config


Distribute 

Local Config


Description 

Deletes the local SPI for SAP configuration 
files on the selected managed nodes and, in 
addition, any files related to the selected 
managed nodes, which reside on the HPOM 
management server. 

Distributes and installs the local SPI for SAP 
configurations on the selected managed 
node(s) 

The contents of the SAP R/3 Admin and SAP R/3 Admin Local tool groups are very similar. 
Table 12 lists only those tools in the SAP R/3 Admin Local tool group that have not already 
been described in Table 11 on page 62 and indicates what each tools does. 

Figure 6 on page 65 shows the tools available in the SAP R/3 Admin Local tool group. 
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Figure 6 SAP R/3 Admin Local Tool Group 

For more information about editing and distributing monitor configurations, see the HP 
Operations Smart Plug-in for SAP Reference Guide. 

The SAP R/3 UN*X and SAP R/3 NT Tool Groups 

These two groups include tools that provide direct, context-sensitive startup of the SAP 
front-end on UNIX and Microsoft Windows platforms respectively. For instance, if you receive 
a performance alert, you can click the Performance icon and open the SAP performance 
analysis tool. 

In addition, the SAP R/3 UN*X group includes a number of tools that involve interactive 
actions with terminal output, for example: Check R/3 Database, Status R/3 Config, or 
Version Verify. These tools are not supported on the Microsoft Windows platform. 

Before you select a tool from one of these groups, you must select the managed node on which 
you want the tool to run. Make sure that you select the tool from the tool group that 
corresponds to the managed node’s platform, for example: UNIX or Microsoft Windows. 

Table 13 lists the tools, available in both tool groups, that open a SAP GUI session. 

Table 13 SPI for SAP Tools that Call SAP Transactions 

Tool Description 
SAP Trans
action code 

Control Panel CCMS control panel RZ03 

DB Performance Shows database performance 
through tables and indexes. 

DB02 

Gateway Gateway monitor SMGW 

Job Maintain Define background jobs SM36 

Job Overview Status of background jobs SMX 
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Table 13 SPI for SAP Tools that Call SAP Transactions (cont’d) 

Tool Description 
SAP Trans
action code 

Job Performance Job performance SM39 

Maintain 
Thresholds 

Maintenance thresholds RZ06 

Operation Modes Maintain operation modes RZ04 

Operation Sets Maintain operation sets SM63 

Performance Workload analysis ST03 

Process Process overview SM50 

Profile 
Maintain 

Profile maintain RZ10 

Servers Server overview SM51 

Syslog System log, local analysis SM21 

Syslog Msg System log message 
maintenance 

SE92 

Users User overview AL08 

The Version Verify tool allows you to compare the installed base version of the SPI for SAP 
with the version of any SPI for SAP components that have been added subsequently. 

Accessing Data on a Managed Node 

The following tools allow quick access to SAP NetWeaver related information from the 
selected managed node. 

Table 14 SAP Information and Platform Availability 

SPI for SAP Tool Name SAP R/3 
UN*X SAP R/3 NT 

Check R/3 database ✓ 

R/3 Info ✓ ✓ 

R/3 Process Logs ✓ 

Java R/3 Frontend ✓ 

Status R/3 Config ✓ 

Checking the SAP NetWeaver Database 

The Check R/3 Database tool establishes a connection to the database server and thus 
provides a rapid way of checking the database connection. 
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SAP NetWeaver Information 

The R/3 Info tool provides the following information for SAP NetWeaver instances that are 
installed on a selected node: 

•	 Hostname 

•	 SAP system name 

•	 Instance name 

•	 Instance number 

•	 SAP release number 

•	 List of processes for the selected instance 

The R3 Info tool is available for both UNIX and Windows nodes and present in both the SAP 
R/3 UNIX and SAP R/3 NT tool groups. 

To display information for a selected managed node: 

1	 In the Node Bank window, select the UNIX or Microsoft Windows node for which you want 
to display an information about SAP NetWeaver. 

2	 In the SAP R/3 UNIX or SAP R/3 NT Tool Group window, click the R/3 Info icon. The 
requested information is displayed, as shown in Figure 7. 

Figure 7 Output from the R/3 Info Tool 

Starting the SAP NetWeaver Front-End 

The Java R/3 Frontend tool makes full use of the distributed architecture of SAP 
NetWeaver. It uses the local sapgui utility (running on the HPOM management server) and 
profile to connect to the desired SAP system. Because multiple SAP systems may be installed 
on a selected managed node, you are prompted with a list of installed SAP systems and 
functional modules. 
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To start the SAP NetWeaver front-end: 

1 In the Node Bank window, select the UNIX node on which you want to start an SAP 
session. 

2 In the SAP R/3 UN*X Tool Group, click the Java R/3 Frontend icon. The local sapgui 
starts, connects to the selected SAP component, and displays the SAP NetWeaver login 
screen. 

Using the SAP NetWeaver front-end locally improves application performance by decreasing 
the data flow across the network. 

R/3 Process Logs 

The R/3 Process Logs tool reports all error conditions in a specific file structure. Also, all 
SAP NetWeaver standard output and standard error information is stored on disk. The log 
analyzer extracts relevant ERROR information for all functional modules of each SAP system 
and displays this information for the selected managed node. 

To display the SAP NetWeaver process log for a selected managed node: 

1	 In the Node Bank window, select the UNIX node for which you want to display a process 
log. 

2	 In the SAP R/3 UN*X Tool Group, click the R/3 Process Logs icon. 

3	 Press Enter. The system displays an output file selection window (see Figure 8). 

Figure 8 Logfile-Output Selection Window 

4 Enter the number associated with the output log file you want to view. For example, if you 
enter 17 for the dev_w0 file, the system displays a log file such as that shown in Figure . 

stdout1-5 and stderr1-5 are always displayed, even if the associated files do not 
contain an error message. 
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5 To access additional process logs, return to the process logs selection window by entering 
the command: 

q! 

In order to use commands related to the vi editor your editor environment variable must 
be set to vi. 

The Status R/3 Config Tool 

The Status R/3 Config tool runs on the selected managed node and provides an ASCII 
representation of the current local SAP NetWeaver configuration. Status R/3 Config lists 
all SAP systems installed on the selected managed node and, in addition, the functional 
modules per system. The SAP NetWeaver process status also provides a list of all established 
SAP NetWeaver processes and their current status. 

Select a managed node, then click the Status R/3 Config icon to display the R/3 
Configuration Status window. 

Figure 9 R/3 Configuration Status Window 
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Launching Tools 

This section provides information on how to launch tools on a node or node groups. 

To launch a tool, follow these steps: 

1 Click Integrations → HPOM for Unix Operational UI and log on to HPOM as the HPOM 
Administrator. 

2 In the Nodes list, right-click on the desired managed node or node group and select Start 
→ SPI for SAP → <Tools> 
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6 Customizing SPI for SAP Policies

The SPI for SAP policies help you monitor the SAP Application servers. You can customize 
these policies depending on the requirements of your IT environment. This chapter includes 
general guidelines about the SPI for SAP policies and explains how you can customize them. 
For more information see the policies section in the HP Operations Smart Plug-in for SAP 
Reference Guide. 

SPI for SAP Policy Group and Policy Types 

You can customize the SPI for SAP policies to suit the needs of your IT environment. However, 
you can use these policies without any modifications. 
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SPI for SAP Policy Groups 

The SPI for SAP policies are organized under the SPI for SAP policy group. 

The SPI for SAP contains the following policy groups: 

SAP NW Java Monitoring 7.0 - This group monitors the health of the J2EE engine of the 
SAP NetWeaver Web Application Server. With the help of a series of policies, you can collect 
metrics indicating the health, availability, and performance of the J2EE engine of an SAP 
NetWeaver Web Application Server. 

SAP NW Java Monitoring 7.1 - This group monitors the health of the J2EE engine of the 
SAP NetWeaver Web Application Server. With the help of a series of policies, you can collect 
metrics indicating the health, availability, and performance of the J2EE engine of an SAP 
NetWeaver Web Application Server. 
72 Chapter 6 



SAP R3 6.x 7.0AS 7.1kernel - This group contains the policies for monitoring the 
availability and health of the Web Application server ABAP on the application server of the 
SAP versions 6.40, 7.0, and 7.1. This includes metrics related to trace files, dispatcher, and 
work processes. 

SAP R3 6.xCI - This group contains the policies for monitoring the health and availability of 
the Web Application server ABAP for the Central instance of the SAP version 6.40. It includes 
metrics related to Idocs, CTS, ABAP dumps, locks, jobs, rfc destinations, spool, security, 
update, users, work processes. 

SAP R3 7.0CI 7.1kernel - This group contains the policies for monitoring the health and 
availability of the Web Application server ABAP for the central instance of the SAP versions 
7.0 and 7.1. It includes metrics related to Idocs, CTS, ABAP dumps, locks, jobs, rfc 
destinations, spool, security, update, users, work processes. 

SPI for SAP Policy Types 

The SPI for SAP policies are of two types: 

• Measurement Threshold policies pertain only to individual metrics 

• Scheduled Task policies pertain to all metrics collected in a specific interval 

Measurement Threshold and Scheduled Task Policies 

Measurement threshold policies define how the collected data is interpreted for the individual 
metric. The rules it contains pertain to threshold values and actions that occur when those 
values are met or exceeded. In general an exceeded threshold generates alerts/messages in 
the HPOM message browser. In HPOM, you can change the threshold within a measurement 
threshold policy by double-clicking the policy and selecting the Threshold levels tabbed page. 

Scheduled Task policies define what metrics are collected in the specified collection interval. 
You can see how this works by double-clicking a Scheduled Task policy. On the policy’s Task 
tabbed page a list of targeted metrics appear in the Command text box. 
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Incoming values for metric SPISAP_0231 are compared against its threshold limits. 

Monitor policies define all metrics for the SPI for SAP application that are scheduled for 
collection at specified interval. Within the name of each monitor policy is its collection interval 
(for example, SPISAP-71-High_1h, where collection interval is one hour). When you open any 
monitor policy, you can see all metrics listed as number and collected within the interval 
following the -m option. 

Basic Policy Customizations 

This section covers basic policy customizations like changing threshold values, scheduling or 
deleting a metric from data collection, opening a metric policy or collector policy and so on. 

Before you begin to customize any of the policies, you must make copies of the original policies 
so that the default policies remain intact. 

Modifying Metric Policies 

You can modify the metric attributes for all monitored instances of SPI for SAP. 

Threshold Level and Actions 

To modify the threshold level and actions, follow these steps:


1 Open the Policy Bank window.


2	 Click SPI for SAP → <SAP_Policy_Group>. 

3	 Select a metric and click Edit from the Actions drop-down list. The Edit Measurement 
Threshold Policy window opens. 
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4 Click the Thresholds tab. 

5 Click the condition you want to modify.


6 Click the different tabs (Threshold, Start Actions, Continue Actions, and End Actions) and 

modify the attributes. 

7 Click Save to save the changes. 

8 Deploy the modified policies as described in Deploying the SPI for SAP Categories and 
Policies to Managed Nodes on page 47. 

Table 1 Metric Attributes 

Attributes 

Threshold 

Duration 

Severity 

Message Text 

Actions 

Description 

Enter a value for the metric data, which when 
exceeded would signify a problem either about to 
occur or already occurring. 

Enter a value for the length of time that the 
incoming data values for a metric can exceed the 
established threshold before an alarm is generated. 

Click the Start Actions tab and then the Message 
tab. Select the desired severity setting from the 
Severity drop-down list. 

Do not modify any of the parameters that are 
enclosed within <> brackets and beginning with $, 
in a message. 

This field provides the ability to add custom

programs.

Operator initiated: These actions are performed 

only upon the initiation of an operator.

Automatic: These actions are performed 

automatically when the metric alarms.
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An alarm can be generated once or multiple times, depending on its Message Generation 
setting in the Modify Threshold Monitor window. You can click the Thresholds settings and 
modify the settings. 

—	 Specify a special reset value: Enter the reset value in the text box displayed. 
Alarms are generated once when the threshold value is exceeded. At the same time, a 
reset threshold value is activated. Only when the reset threshold value is exceeded, 
does the original threshold value become active again. Then when the threshold value 
is again exceeded, another alarm is generated and the process starts all over again. 

—	 Use same as threshold value: Alarms are generated once when the monitoring 
threshold value is exceeded. Alarms reset automatically when metric values are no 
longer in violation of the thresholds and are generated again when the threshold is 
exceeded. 

Message Severity 

To modify the message and severity of a policy, follow these steps:


1 Open the Policy Bank window.


2	 Click SPI for SAP → <SAP_Policy_Group>. 

3	 Select a metric and click Edit from the Actions drop-down list. From the Edit Threshold 
window click Thresholds. 

4	 Click Start Actions tab and click Message. 

You can modify the following attributes:


Severity: Indicates the importance of the event that triggers this message.


Message Text: You can modify the text of the message but do not modify any of the 

parameters—beginning with $and surrounded by <> brackets—in a message.
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Advanced Policy Customization 

Advanced policy customizations include making copies of default policy groups to customize a 
few settings and deleting whole groups of metrics within a policy’s command line. 

Creating New Policy Groups 

You can separate the custom policies that you create from the original default policies by 
creating new policy groups. Before you create a new policy group you must first determine the 
metrics and policies you want to modify. To create a new policy group, follow these steps: 

1 Create a new policy group: 

a Open the Policy Bank window and click SPI for SAP. 

b Select the policy group you want to use and click Edit  from the drop-down list. 
The Copy Policy Group window opens. 

c Rename the group. 

d Select a Parent Group. 

2 Click Save. The new policy group is saved. 

3 Copy the required policies to the newly created policies and rename it.


4 Click Save.


Changing the Collection Interval 

To change the metric collection interval, simply change the Polling Interval in the appropriate 
collector policy. For example, to change the collection of default metrics from 5 minutes to 10 
minutes for the SPI for SAP policy group, follow these steps: 

1 Open the Policy Bank window and click SPI for SAP policy group. 
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2 Select a scheduled policy and click Edit  from the drop-down list. The Edit Policy 
window opens. 

3 Click the Scheduled Task tab. 

4 Change the values accordingly in the fields. 

5 Click the Message Failed tab. 

6 Change the severity, message text, and object. 

7 Click Save. 

8 Distribute the new policies as described in Deploying the SPI for SAP Categories and 
Policies to Managed Nodes on page 47. 

Changing the Collection Interval for Selected Metrics 

To change the collection interval for selected metrics, copy the appropriate collector policy. 
Rename the policy with a name reflecting the new interval, deleting all but the metrics you 
are changing. Set the new interval. Edit the original policy to remove the changing metrics. 

For example, to change the collection interval to 10 minutes for metrics 5-8, follow these steps: 

1 Open the Policy Bank window and click SPI for SAP policy group. 

2 Click SPI for SAP → SAP R3 6.xCI → r3mondmp. 

3 Click Edit from the drop-down list. 

4 Click the Scheduled Task tab. 

5 In the Minute box, change the polling interval from 5 minute to 10 minutes. For example, 
0, 10, 20.... 

6 Click Save. 
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7 Re-distribute the modified policies as described Deploying the SPI for SAP Categories and 
Policies to Managed Nodes on page 47. 
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7 The SPI for SAP in a high-availability Cluster

This chapter explains how to install the SPI for SAP in a high-availability environment such 
as an MC/ServiceGuard cluster. 

In this Section 

The information in this section helps you to understand the process of installing and 
configuring the SPI for SAP on SAP servers running in a high-availability environment such 
as an MC/ServiceGuard cluster. For information about installing the SPI for SAP on an 
HPOM management server running in a high-availability cluster, see Installing the SPI for 
SAP Software on page 18. 

Although the information provided in this section uses MC/ServiceGuard to explain cluster 
configurations, the basic concepts are the same for any high-availability environment as far as 
the SPI for SAP is concerned. 

Cluster Configurations 

The most common implementations of high-availability software in an SAP NetWeaver 
Landscape involve configuring the central-instance server and the database server in a 
cluster and installing either one, combined package on the central-instance server or two 
separate packages on the central-instance server and the database server, respectively. 
Typically, application servers are not configured as part of the MC/ServiceGuard cluster. The 
two configurations which we describe in more detail in this section are: 

• single package 

The SAP database and central instance are located on the same server and included in the 
same MC/ServiceGuard package. The combined package can be switched temporarily to 
the secondary node in the event of problems. 

• twin package 

The SAP database and central instance are located on different servers. Either package 
can be switched temporarily to the alternative node in the event of a problem on the 
primary (physical host 1) or secondary (physical host 2 or backup) node. 

The Single-Package Configuration 

In the single package concept, the server where the database and central instance normally 
run is included in a cluster with another server, which will act as the secondary node in the 
event of a package switch. The secondary node can perform any one of the following roles: 
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• SAP application server 

• SAP test or development system 

• Stand-by 

The application servers, which are not included in the cluster, reference the MC/ServiceGuard 
package (❸) by means of its relocatable IP address, not by reference to the fixed IP address of 
the node on which the MC/ServiceGuard package is running. If a problem occurs, the central 
instance and database are taken down on the primary or physical host 1 node (cluster node 
❶), and then brought up again on the secondary or physical host 2 node (cluster node ❷). At 
the same time, the shared disks are deactivated on the primary node and reactivated on the 
secondary node. 

Figure 1 The Single-Package Configuration 

Once these actions have been completed by MC/ServiceGuard, the application servers can 
reconnect to the central instance and database (❸ in Figure 1 on page 82) using the same 
relocatable IP address, which, as the name suggests, moves with the package. 

The Twin-Package Configuration 

In the two-package concept, the central instance and the database are installed on different 
servers, which for the sake of convenience we can call cluster nodes ❶ and ❷ respectively, as 
illustrated in Figure 2. The central-instance server and the database server form a 
high-availability cluster, where each server can act as the secondary node for the other in the 
event of a package switch. 
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Figure 2 The Twin-Package Configuration before a Package Switch 

The application servers are not included in the cluster and it refers each package by means of 
each package’s own relocatable IP address—not the fixed IP addresses of cluster-nodes ❶ and 
❷. 

If a problem is identified on the central-instance server, the central instance (❸) is taken down 
on cluster node (❶), and then brought up again on the cluster node (❷). At the same time, the 
central instance shared disk is deactivated on the primary node and reactivated on the 
secondary node. 

Figure 3 shows the situation after the switch of the SAP central- instance package (❸). Once 
the central-instance package is up and running on the cluster node (❷), the application 
servers can reconnect to the central instance using the same IP address as before the fail over, 
namely; the central-instance package’s relocatable IP address, which moves along with the 
package at the time the fail over occurs. 
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Figure 3 Twin-Package Configuration after a Package Switch 

Pre-requisites 

The information in this section is designed to help you install and configure the SPI for SAP 
in a high-availability environment: it is not intended to explain either how to set up the 
high-availability software or HP Operations Manager. Before you start the process of 
installing the SPI for SAP in a high-availability environment, please read through and 
consider the information included in the following sections: 

• Software Requirements on page 84 

• Configuration Requirements on page 85 

• Service Reports and Performance Graphs on page 85 

• Service Views on page 85 

Software Requirements 

High-availability software must already be correctly installed and configured in your SAP 
landscape, and the cluster should function correctly. For example, you have to decide whether 
to configure one package for the central instance and the database server or set up separate 
packages for each part. These decisions become important later in the configuration process. 
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Configuration Requirements 

The SAP servers in the MC/ServiceGuard cluster must already be configured as HPOM 
managed nodes with the appropriate HPOM agent software and functionality installed and 
running. 

All physical nodes in the high-availability cluster must be added to the HPOM Node Bank 
window. You also need to add to the HPOM Node Bank window (as node type "Other"- 
Message only) to the host you define as the HPOM-message host name in the host-mapping 
section of the r3itosap.cfg file. For more information about defining HPOM-message host 
name, see Specifying SAP Clients to Monitor on page 50. 

Service Reports and Performance Graphs 

If you want to generate SPI for SAP service reports and performance graphs for all the nodes 
in the MC/ServiceGuard cluster, make sure that: 

•	 the appropriate performance-agent functionality (Embedded Performance 
Component or the HP Performance Agent) is installed, configured, and available on all the 
nodes in the MC/ServiceGuard cluster. 

•	 the appropriate SPI for SAP R/3 Performance Agent integration functionality is installed, 
configured, and available on all the nodes in the MC/ServiceGuard cluster. For more 
information about installing and configuring the SPI for SAP R/3 Performance Agent, see 
the HP Operations Smart Plug-in for SAP Reference Guide. 

•	 both HP Performance Manager and Reporter, are installed, correctly configured, and 
available on a system, which can see the cluster nodes. Note that these services are not 
usually (and do not need to be) part of the cluster itself. 

Service Views 

You can use tools provided by the SPI for SAP to generate Service Views automatically. If you 
want to make use of Service Views with the SPI for SAP, you need to install the Navigator and 
set it up to see the services you want the SPI for SAP monitor in the SAP environment. You 
will also have to ensure that the SPI for SAP performance integration is installed and 
configured to collect the appropriate performance-related data. 

The service-discovery process uses information stored in the r3itosap.cfg file to determine 
which SAP Systems are to be monitored. You need to ensure that you have entered in the 
Host- Mapping section of the r3itosap.cfg file the names of the nodes in the 
high-availability cluster. For more information, see Configuring the SPI for SAP in a 
High-availability Environment on page 88. 
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Installing the SPI for SAP in a High-availability Environment 

To use the SPI for SAP in an MC/ServiceGuard environment, you have to install the HPOM 
agent and SPI for SAP actions, commands, monitors, and policies on all nodes in the cluster 
where the SAP package can run—both the primary node and secondary (or backup) node. 

It is always a good idea to ensure that the daily backup of the SAP environment is correctly 
set up and that there is a valid backup available for restore before you start the installation of 
the SPI for SAP actions, commands, monitors, and policies. 

Before you distribute the SPI for SAP to the cluster nodes, you need to assign the appropriate 
SPI for SAP policy groups. For example, you have to assign a central-instance policy group 
such as SAP R3 6.xCI to all managed nodes where a package that includes a SAP R/3 6.x 
central instance can run, or SAP R3 7.0CI/7.1kernel to all managed nodes where a package 
that includes a SAP R/3 7.0 central instance can run. 

If no SAP instance is running on the node, the SPI for SAP monitors will work immediately 
after installation, but will not generate any messages. Note that SPI for SAP applications 
which open a SAP dialog will return an error if you try to execute them on a stand-by node, 
where no SAP package is running. 

However, the r3status monitor sends an SAP System down message after you run the 
monitor for the first time. The HostMapping entry in the r3itosap.cfg file maps the 
physical hostname of the system to the virtual hostname of the central instance. The message 
browser indicates that this message originates from the virtual hostname. If the r3status 
monitor on the other node (where SAP is running) also runs for the first time, the monitor 
will send an SAP System up message, which again appears to be arriving from the virtual 
hostname. In effect, there will be two contradictory messages from the virtual host at the 
same time. The order of these messages cannot be predicted. This event occurs only for the 
first r3status run because initially the r3status.his files are not available on each node. 

If an application-server instance is already running on the managed cluster-node, the 
monitors will run and generate messages relating to the application instance. You should 
configure the monitors that normally only run on a central-instance server in such a way that, 
when they start after a package switch, they do not generate messages relating to problems 
with the application server instance, too, since this could lead to the generation of duplicate or 
misleading messages. For more information, see Special-Case Scenarios on page 91. 

Installing the SPI for SAP Monitors 

You install the SPI for SAP monitors in an MC/ServiceGuard environment in the same way as 
in a normal environment, that is; using the standard HPOM template-assignment and 
template-distribution mechanisms. The only difference is that you have to perform the 
operation for each physical node in the cluster, as follows: 

1 Pre-requisites 
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Before you start the installation of the SPI for SAP monitors, make sure that you have 
completed all the steps described in the section Configuring SAP-Specific Tasks on 
page 31, which walks you through the process of setting up the appropriate accounts, 
logins, paths, and permissions required to ensure that SAP and HPOM can communicate 
efficiently. 

If you do not ensure that the appropriate user accounts and permissions have been 
set up in both SAP and HPOM before you start the installation and configuration 
of the SPI for SAP described in this section, the SPI for SAP action, commands, 
and monitors will not function correctly. This could lead to the generation of 
incorrect or duplicate messages and the collection of misleading performance data. 

2 Set up the r3itosap.cfg file to reflect the high-availability cluster. 

You need to enter information about the configuration of the high-availability cluster in 
the Host-mapping section of the r3itosap.cfg file. For more information about the 
r3itosap.cfg file, see Specifying SAP Clients to Monitor on page 50. 

3 Monitor configuration 

Configure the SPI for SAP monitors, which you want to run on the cluster nodes. The 
configuration must be identical for all the nodes in the MC/ServiceGuard cluster in order 
to avoid the generation of confusing messages and potentially misleading performance 
data after a package switch. For more information, see Configuration Values for SPI for 
SAP Monitors on page 37. 

The only exception to this rule is when the secondary node is already configured as 
an application server. For more information, see Special-Case Scenarios on 
page 91. 

4 Assign and distribute components 

Use the HPOM GUI to assign and distribute the appropriate SPI for SAP components to 
each physical node in the cluster. The policies you assign must match the version of SAP, 
which is running on the managed node. In addition, you must make sure that you assign 
exactly the same components (actions, commands, monitors, and policies) to all the nodes 
in the cluster. In this way, you ensure that the SPI for SAP continues to monitor the same 
SAP instances in the same way, regardless of where in the high-availability cluster the 
SAP instance is running. 

For more information about assigning and distributing SPI for SAP components to HPOM 
managed nodes, see Configuring HPOM Administration Tasks on page 41. You will need 
to complete all the instructions for each node in the high-availability cluster. 

5 Special considerations 

On each node in the MC/ServiceGuard cluster, ensure that each monitor can see its 
history file, r3<monitor_name>.his, both before and after a fail-over package switch by 
setting the history path in each monitor’s configuration file, r3<monitor_name>.cfg. For 
more information about the location of SPI for SAP monitor configuration files and the 
options you need to set and change, see Monitor History Files in a High-availability 
Cluster on page 89. 
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Configuring the SPI for SAP in a High-availability Environment 

In a “normal” high-availability cluster where the primary and secondary nodes are intended 
to have identical roles, you approach the process of installing the SPI for SAP in the same way 
as if you had to install the SPI for SAP twice, with the following cautions: 

1 SAP logins and accounts for the SPI for SAP 

Use the HostSapAssign section in the r3itosap.cfg file to set up the SAP logins, 
accounts and so on required by the SPI for SAP on all physical nodes in the cluster. For 
more information, see Defining SAP Logins in a High-Availability Cluster on page 91. 

2	 Tell the SPI for SAP about the high-availability cluster nodes, which you want 
to monitor 

You need to enter information about the configuration of the high-availability cluster in 
the Host-mapping section of the r3itosap.cfg file: the r3itosap.cfg file is the file you 
use to specify the SAP Systems, which you want to monitor with the SPI for SAP. For 
example, you need to specify the names of the physical hosts in the high-availability 
cluster and the name of the virtual or relocatable host with which you want to associate 
the messages originating from the cluster when the messages appear in the HPOM 
message browser. 

You might also need to specify in the list of physical nodes the name of the host defined in 
SAPLOCALHOST, but only if it is different from the host you want to associate with 
incoming messages. For more information about the r3itosap.cfg file, the entries you 
need to add to the host-mapping section, and the required syntax, see Specifying SAP 
Clients to Monitor on page 50. 

Lastly, in order to ensure that automatic or operator-initiated actions are always able to 
open a SAP GUI on the virtual node in the high-availability cluster, you need to add a 
HostSapAssign entry to the r3itosap.cfg file, which specifies the host name defined in 
the variable SAPLOCALHOST. 

3	 Configure the SPI for SAP monitors 

You have to configure the SPI for SAP monitors in exactly the same way on all the 
physical nodes in the cluster, where the package is configured to run. For more 
information about configuring the SPI for SAP monitors, see HP Operations Smart 
Plug-in for SAP Reference Guide. 

A local configuration that is specific to one particular node in the cluster is not 
recommended as it can lead to a situation where different monitoring conditions are 
applied after a package is switched. Special-Case Scenarios on page 91 describes one or 
two exceptions to this rule. 

4	 Assign and distribute the SPI for SAP components 

In this task, you assign and distribute the appropriate SPI for SAP components to all the 
physical nodes in the high-availability cluster, where the package is configured to run. For 
more information about assigning and distributing components to the managed nodes, see 
Assigning SPI for SAP Policies to SAP Nodes on page 57. 

5 History files for the SPI for SAP monitors 

Make sure that the correct history file is available for each SPI for SAP monitor both 
before and after a fail-over package switch. For more information, see Monitor History 
Files in a High-availability Cluster on page 89. 

6 Special requirements in your SAP environment 
88	 Chapter 7 



 list. 
Make sure that any special requirements in your SAP environment are known to the SPI 
for SAP monitors. For more information, see Special-Case Scenarios on page 91. 

If the secondary node in the cluster has the additional role of application server, make sure 
you read the instructions in Special-Case Scenarios on page 91 before you start the 
configuration process. 

Host Mapping on Cluster Nodes 

If the agent discovers that multiple IP addresses are assigned to a single physical node in the 
high-availability cluster, the messages the agent sends show the host name associated with 
the IP address that is registered on the management server for the cluster node; this is the 
name of the node where the cluster package is running at the time the message is sent. 

Although this behavior is a feature of the agent in cluster environments, it overrides the SPI 
for SAP’s host-mapping functionality, which can lead to a situation where the wrong name 
appears to be associated with messages displayed in the message browser. To ensure that the 
host-mapping feature works as intended and the correct hostname is displayed in SPI for SAP 
messages coming from the high-availability cluster, you must disable the agent feature on the 
managed node, as follows: 

1	 Log on as a user with administrative privileges to each physical node in the 
high-availability cluster where an  agent is running and open a command shell. 

2	 On HTTPS agents managed by HPOM for Linux: 

ovconfchg -ns eaagt -set OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES 
'<IP_Address,IP_Address,...>' 

Use the on each physical node in the high-availability cluster to specify the IP address of 
the package (the virtual node) that you want to replace the cluster-node name as 
registered on the management server, when a message from one of the cluster nodes 
appears in the message browser. If multiple packages are running in the cluster (for 
example, for HPOM and for Oracle), use commas "," to separate multiple IP addresses in the

Spaces are not allowed in the list of IP addresses defined by 
OPC_SET_PROXY_FLAG_FOR_IP_ADDRESSES. Never include the IP address specified in 
OPC_IP_ADDRESS in the list of IP addresses. 

3	 Restart the agent with the new configuration using the following commands: 

opcagt -kill; opcagt -start 

Monitor History Files in a High-availability Cluster 

The SPI for SAP alert monitors r3monal, r3mondev, r3monpro, and r3status have their own 
history files with the extension .his, for example; r3monal.his. Each time one of these SPI 
for SAP monitors starts, it relies on the contents of its history file r3<monitor_name>.his to 
determine the last events monitored and, as a result, the point at which the current monitor 
run should start. This mechanism is designed to avoid the problem of duplicate messages. 

Note that r3monal writes new information to its history file only if the SAP System it is 
monitoring is available and the SPI for SAP monitors can connect. If the SAP System being 
monitored is not available, r3monal only updates the time stamp to reflect the time of the 
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latest monitor run. The monitors r3mondev, r3monpro, and r3status, on the other hand, 
write to their respective history file after each monitor run whether the SAP System they are 
monitoring is available or not. 

History File r3monal.his for the r3monal Monitor 

#----------------------------------------------------------

# Keyword SAP SAP SAP Last Scan

# System Number Instance Time

LastScannedSystem =SP6 =33 =DVEBMGS33 =1073908785


The history files for the SPI for SAP monitors are usually stored on the managed node where 
the monitors are running in a directory specified in each monitor’s configuration file, 
r3<monitor_name>.cfg. By default, this directory is /var/opt/OV/conf/sapspi for all 
UNIX managed nodes except AIX, which uses the directory /var/lpp/OV/conf/sapspi, and 
%OVAGENTDIR%\conf\sapspi for Microsoft Windows managed nodes. However, if the cluster 
package switches to another node, then the SPI for SAP monitors can no longer access the 
most recent history files stored on the failed cluster node. This may lead to the generation of 
duplicate messages—messages that have already been sent to HPOM. For r3monal, the 
duplicate messages can be avoided by enabling CCMSAcknowledgeMessage. Refer to the 
r3monal: CCMS Acknowledge Message section of the HP Operations Smart Plug-in for SAP 
Reference Guide for more information on CCMSAcknowledgeMessage. 

The r3moncol monitors keep their history information in the SAP tables. As a result, they do 
not have a .his history file. The r3mondev monitor reads the SAP trace and log files, and 
keeps the line number for each file in r3mondev.his. Therefore, in principle, r3mondev is 
prone to sending duplicate messages if the package is switched to the other node. If 
r3mondev.his is stored on the local disks and r3mondev on the new node, the SPI for SAP 
starts scanning from a point that was scanned on the previous node already. 

However, after starting an SAP instance, new dev_* files will be created. Most of the dev_* 
files will be copied to dev_*.old files before creating new files. Therefore, r3mondev never 
monitors the dev_*.old files. 

r3mondev detects (through the Inode column in r3mondev.his) if a file is created a new, and 
then starts scanning the new file from the beginning. Therefore, you can use the default 
configuration for r3mondev and it is not necessary to place r3mondev.his on a shared disk. 

Special Considerations for the Alert Monitors 

This section contains information which is intended to help you set up the SPI for SAP alert 
monitors in a high-availability environment. For more detailed information about the 
alert-monitor configuration files and keywords for r3monal in particular, see the HP 
Operations Smart Plug-in for SAP Reference Guide. To set up the SPI for SAP alert monitors 
in a high-availability environment, you need to carry out the following steps: 

1 Enable (=1) the r3monal monitor’s auto-acknowledgement feature for CCMS alerts in 
SAP to avoid duplicate messages appearing in the HPOM message browser. 

2 Define a CCMS monitor set, for example; "HPOM", and a CCMS monitor, for example; 
"SPI Monitoring", for the messages you want to forward from CCMS to the HPOM 
message browser. Note that the monitor-set feature can be only used with the XMI/XAL 
interface. 
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Defining SAP Logins in a High-Availability Cluster 

When setting up the SPI for SAP in a high-availability environment, remember to include 
references to SAP instances on all physical nodes in the cluster in the r3itosap.cfg file, the 
file which the SPI for SAP uses to define all SAP logins. If you make any changes or additions 
to this file, it is essential that you use the names of the physical nodes in the high-availability 
cluster, since the SPI for SAP monitors reference the physical node (and not the relocatable IP 
address associated with the package) when they do a host-name lookup. 

The SPI for SAP uses the host-mapping section of the r3itosap.cfg file to define 
information about the configuration of the high-availability cluster, such as the names of the 
physical hosts and the name of the managed node to be associated with messages originating 
from the cluster. For more information, see Configuring the SPI for SAP in a High-availability 
Environment on page 88. 

If the secondary node in the high-availability cluster is already configured as an SAP 
application server, then the logins for both the SAP central instance (=CI) and the application 
server (=APP) can lead to problems with some of the SPI for SAP components, for example; 
r3moncol and r3monpro, both of which require special configuration as described in 
Special-Case Scenarios on page 91. 

To ensure that automatic or operator-initiated actions are always able to open an SAP GUI on 
the virtual node in the high-availability cluster, add a HostSapAssign entry to the 
r3itosap.cfg file, which specifies the host name defined in the variable SAPLOCALHOST. 

Special-Case Scenarios 

For reasons of efficiency or cost, the secondary (or backup) node in a high-availability cluster 
might already be in use as an application server. If this in the case in your environment and 
regular high loads mean that you need the central instance to maintain the same performance 
level after the fail-over package switch as before, you have the option of shutting down the 
application server on the secondary node after the fail-over so that the machine’s performance 
is available solely to the central instance. You can then share the user load between any other 
available application servers. 

If performance is not an issue in your environment, you can choose to keep the application 
server instance running on the secondary node even after the fail-over package switch. 
However, if an instance of an SAP application server is running on the same machine as an 
SAP central instance, you will need to ensure that the SPI for SAP monitors are made aware 
of this fact and do not generate messages for both the central instance and the application 
server. The SPI for SAP monitors which are only designed to work with the central instance 
should be set up to exclude monitoring of the application-server instance. The r3moncol and 
r3monpro monitors, for example, require special attention. 

Each SPI for SAP monitor has a configuration file that you use to define which SAP 
NetWeaver instances in your SAP landscape it should watch and, in addition, what 
information it should collect. For example, you use the r3monpro.cfg file to configure the 
r3monpro monitor to collect information about either the central-instance processes or the 
processes tied to the application-server instance. Note that the HP Operations Smart Plug-in 
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for SAP Reference Guide has much more information about the individual SPI for SAP 
monitors as well as additional hints about what aspects you can configure to suit the 
requirements of your environment. 

The SAP instance number associated with the application server already running on the 
secondary node cannot be the same as the SAP instance number associated with the SAP 
central instance, which starts on the secondary node after the fail-over package switch. 

Table 2 shows which monitors apply to which SAP instance. 

Table 2 SPI for SAP Monitors 

SPI for SAP Monitor 
Name 

Central 
Instance 

Application 
Server 

r3monaco ✓ 

r3monale ✓ 

r3monal a ✓ 

r3monchg ✓ 

r3moncts ✓ 

r3mondev ✓ ✓ 

r3mondisp ✓ ✓ 

r3mondmp ✓ 

r3monjob ✓ 

r3monlck ✓ 

r3monoms b ✓ 

r3monpro ✓ ✓ 

r3monrfc ✓ 

r3monspl ✓ 

r3monsec ✓ 

r3status ✓ ✓ 

r3montra ✓ 

r3monupd ✓ 

r3monusr ✓ 

r3monwpa ✓ 

a. CCMS 4.x only 

b. Due to changes in SAP, the operation-mode monitor r3monoms is 
not supported with WebAS 7.0. 
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The r3moncol Monitor in a High-Availability Cluster 

The r3moncol monitor collects alerts from all the SPI for SAP alert monitors such as, for 
example; r3monale, the iDOC-status monitor, and r3mondmp, the ABAP-dump monitor. The 
alert monitors themselves ensure that alert collectors are executed according to a defined 
schedule and report any messages that come back from the called function. 

The r3moncol monitor is only intended to run on an SAP central instance: it is not designed to 
run on an application server. As a consequence, if the secondary node in a high-availability 
cluster is running an application server, care has to be taken to ensure that the monitors that 
are started when the central instance comes up on the secondary node after the fail-over 
switch do not become confused about which SAP instance to monitor—application server or 
central instance. 

To avoid problems when the central instance and the application server are running on the 
same cluster node at the same time, for example; after a system fail over, you need to ensure 
that each of the monitors which the r3moncol starts when the central instance comes up on 
the secondary node is configured to ignore alerts associated with the application server and 
monitor only those alerts that belong to the central instance. This means modifying the 
configuration file of each of the SPI for SAP’s central-instance monitors listed in Table 2 on 
page 92 in such a way as to make sure that the monitor is tied to a particular SAP 
central-instance number, for example; 00. By default, the SPI for SAP monitors are configured 
to monitor all SAP instances present on the node, which in this special-case scenario would 
include the unwanted application-server instance, too. 

Tying the r3monale Monitor to an SAP Instance Number on page 93 illustrates how the 
configuration file for the r3monale monitor on the secondary node would look if you 
configured r3monale to monitor only the central instance (for example=00) on the secondary 
node nodename2.com and not the instance of the application server (=01), which is already 
running. Note that the node name you specify in this file is the name of the physical cluster 
node. 

Tying the r3monale Monitor to an SAP Instance Number 

#AlertMonFun SAP SAP SAP SAP Alert Enable=1 (...)


# Host System Number Client Monitor Disable=0 (...)


#----------------------------------------------------------------------------


AlertMonFun =ClusterNodeA =CI =00 =099 =ALE =1 (...) 

AlertMonFun =ClusterNodeB =CI =00 =099 =ALE =1 (...) 

The r3monpro Monitor in a High-Availability Cluster 

The r3monpro monitor scans for and checks all processes associated with a given SAP 
instance, for example; the dialog, enqueue, update, batch, dispatch, message, gateway, and 
spool work processes. However, the r3monpro monitor can be used to monitor database 
processes, too. 

If the secondary node in a high-availability cluster is running an application server, then care 
has to be taken after a package switch that the r3monpromonitor started by the package does 
not assume that the processes associated with the application server also need to be 
monitored along with the processes belonging to the central instance. One way of ensuring 
this is to specify the exact number of processes to be monitored by r3monpro in the 
r3monpro.cfg file (in the column: Process number=#). The number of processes to monitor 
must be the same on each node both before and after the fail-over package switch. 
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In addition, if you want to ensure that the r3monpro monitors only those processes belonging 
to a specific SAP instance on a node where multiple SAP instances are running, for example; 
after a package switch, you have to make sure that the r3monpro monitor knows which SAP 
instances it is supposed to watch. You can do this by modifying the r3monpro.cfg file on the 
adoptive node in the cluster in such a way that each SAP instance number (defined in the 
column: SAP Number=) is linked to the appropriate process name, as illustrated in Tying the 
r3monpro Monitor to an SAP Instance Number. 

Tying the r3monpro Monitor to an SAP Instance Number 

#AlertInstMonPro SAP SAP Process Enable Mode Process (...) 
# System Number name =1 number (...)
#--------------------------------------------------------------------------
AlertInstMonPro =T11 =00 =saposcol =1 =Exact =1 (...) 
AlertInstMonPro =T11 =01 =saposcol =1 =Exact =1 (...) 

Performance Tools in a High-availability Environment 

If you are the using the Performance Agent (or OVO Embedded Performance Component) to 
monitor SAP NetWeaver in an MC/ServiceGuard environment, you must install the 
performance agents on both nodes in the cluster, namely; the primary and secondary nodes, 
and then configure the performance agent to monitor the same SAP System and Instance on 
both nodes. 

Since r3perfagent will always use the physical hostname in a cluster environment, you must 
specify the clustered SAP-system details by configuring r3perfagent with the manual mode 
(888). If you are configuring r3perfagent on a physical cluster node, r3perfconfig may offer 
you the option (x) on the SAP system with the virtual node. In this case, use the manual 
configuration (888) by specifying the physical cluster node name. 

In the event of a fail over and subsequent package switch, the Performance Agent stops 
collecting values for the SAP metrics on the host node and, as soon as the package comes up 
on the secondary node, starts to monitor and report the appropriate SAP metrics on the 
secondary node. Metrics for physical components such as CPU and disk performance continue 
to be collected on both nodes irrespective of where the package is running. This needs to be 
taken into account when generating and publishing performance reports and graphs. 

The SPI for SAP service reports do not correlate the values collected by the Performance 
Agent on the cluster over time. The reports process the data separately for each cluster node. 
This means that if a package switches from the primary node to the secondary (backup) node, 
the values for the switched instance will be split between the two nodes in the cluster. If the 
scenario described reflects the situation in your environment, you will have to use the reports 
from both nodes to get a complete view of SAP performance. 
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Service Reports and Performance Graphs in a High-availability 
Environment 

If you want to generate SPI for SAP service reports and performance graphs for all the nodes 
in the high-availability cluster, make sure that both the HP Performance Manager and 
Reporter, are installed, correctly configured, and available on a machine that is visible to the 
cluster nodes. You will also have to ensure that the appropriate performance-agent 
functionality (Embedded Performance Component or the HP Performance Agent) is installed, 
configured, and available on all the nodes in the high-availability cluster and the appropriate 
SPI for SAP performance sub-agent integration functionality is installed and correctly 
configured. 

Note that operating system reports are tied to the individual physical nodes in the cluster. 
This means that the SPI for SAP monitors are collecting operating system data even when 
the SAP package is not running, for example; on the secondary (backup) node. 

You can generate reports and graphs for the high-availability cluster using SAP-, hardware-, 
and network-related metrics, which the performance agents collect from the physical nodes in 
the cluster. Since the Performance Agent run on all the physical nodes in the cluster and are 
independent of the SAP package, reports which use hardware- or network-related metrics can 
even be configured to include the periods during which the SAP package is not running, for 
example; on the secondary node before a package switch and on the primary node after the 
package switch. Note that SAP-related metrics such as status and availability are linked to 
the physical node where (and during the time which) the package is running. 

Service Views in a High-Availability Environment 

You can use tools provided by the SPI for SAP to generate Service Views of the SAP 
environment automatically. If you want to make use of Service Views with the SPI for SAP, 
you need to install the Navigator and set it up to see the services you want the SPI for SAP to 
monitor in the SAP landscape. You will also have to ensure that the SPI for SAP performance 
integration is installed and configured to collect the appropriate performance-related data. 

The service-discovery template needs to be able to read the r3itosap.cfg file to determine 
the SAP Systems which the SPI for SAP is monitoring and, more specifically, the 
host-mapping section. The information in the host-mapping section of the r3itosap.cfg file 
specifies the names of the nodes in the high-availability cluster and, in addition, which node 
name should be associated with messages generated by nodes in the cluster. For more 
information about the contents of the r3itosap.cfg file, see Configuring the SPI for SAP in 
a High-availability Environment on page 88 and Specifying SAP Clients to Monitor on 
page 50. 

Only physical nodes can appear in the service tree, and data can only be collected for the 
physical node on which the package is running at a given point in time. 
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 Removing the SPI for SAP in a High-availability Environment 

The SPI for SAP software and functionality has to be removed from each individual physical 
node in the MC/ServiceGuard cluster, where the product was installed and configured. This 
will involve the following steps: 

1 If you installed the SPI for SAP performance sub-agent on the managed nodes in the 
cluster, you will have to remove it and its components from the SAP managed nodes in the 
MC/ServiceGuard cluster before you proceed to step two. For more information, see 
Removing SAP R/3 Performance Agent from SAP Managed Nodes on page 130. 

2	 After removing the SPI for SAP performance sub-agent, you have to remove the SPI for 
SAP components from the SAP managed nodes in the MC/ServiceGuard cluster. For more 
information, see Removing the SPI for SAP from HPOM Managed Nodes on page 131. 
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8 Using the Smart Plug-in for SAP

This chapter introduces the SPI for SAP integration with HPOM and describes a typical SPI 
for SAP session. 

Introduction 

After you have installed and configured the SPI for SAP you can begin to use it to monitor 
your SAP NetWeaver system environment. 

When you log on to HPOM using the user name and password of an operator with SAP 
responsibilities, you will see additional SAP-specific components in the Node Bank, Message 
Group windows. You will also see SAP related messages in the HPOM message browser. 

The HPOM Node Bank Window 

The Node Bank window contains all the nodes for which the operator is responsible. The 
nodes list the basic information like IP address, system type, and policies. 

Figure 4 HPOM Managed Nodes Window 

Before you can use any of the application functions with a particular managed node, you need 
to select the node in the Node Bank window. 
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The HPOM Message Groups Window 

The All Message Groups window contains all the message groups for which a particular 
operator is responsible. In this window you can review the status of each group and select 
specific groups for message review. HPOM uses message groups to combine management 
information about similar or related managed objects under a chosen name and provide 
status information on a group level. 

Figure 5 HPOM Message Groups 

When you are logged on as an operator with SAP responsibilities, your Message Groups 
window contains some or all of the SAP-specific message groups listed in Table 3 depending 
on the responsibilities assigned to you by the HPOM administrator. 

Table 3 SPI for SAP Message Groups 

Message Group 

R3_ABAP-4


R3_ALE


R3_Buffers


R3_Backup


Contents/Purpose 

ABAP/4 database events 

Events concerning the status of iDOCs in the 
NetWeaver System 

SAP NetWeaver instance buffer problems 

SAP NetWeaver backup messages 
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Table 3 SPI for SAP Message Groups (cont’d) 

Message Group 

R3_CCMS


R3_CTS


R3_DB


R3_Dispatch


R3_Enqueue


R3_General


R3_Jobs


R3_MON_ERROR


R3_Performance


R3_RFC


R3_Roll-Paging


R3_Security


R3_Spooler


R3_State


R3_Syslog


R3_Trace


R3_Transport


R3_Update


R3_User


R3_WP


R3_XMI


Contents/Purpose 

CMMS alert messages from r3monal when it is 
configured to use the XMI/XAL interface 

Correction and transport-system alert messages 

Internal SAP NetWeaver database events 

ABAP dispatcher events 

Enqueue server messages 

General and SAP NetWeaver collector messages 

SAP NetWeaver jobs 

SPI for SAP monitor-specific error messages 

SAP NetWeaver performance messages 

Messages from r3monrfc, the RFC-destination 
monitor. 

Rolling and paging activities 

Events relating to the security of SAP NetWeaver 
systems 

Spooler events 

Configuration status information 

SAP NetWeaver entries in the syslog log files 

Tracing information if trace is switched on 

Transport related messages 

Update error messages 

User and usage messages 

Work process events 

Special syslog XMI messages 

Changing Default Message-Group Settings 

For the sake of convenience, the SPI for SAP automatically assigns messages generated by its 
monitors to particular message groups. For example, messages relating to the database are 
assigned to the R3_DB message group. This makes it easier to understand the general theme 
of a problem when browsing through messages in the HPOM message browser. However, you 
can change these default settings to suit the demands of your environment. 
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For example, if you configure r3monal, the SPI for SAP’s CCMS Alert monitor, to use the XMI/ 
XAL interface in SAP, the SPI for SAP automatically assigns any messages generated by 
r3monal to the R3_CCMS message group. However, there are a large number of messages from 
this source, and it can be helpful to re-assign the messages to sub-groups, which more 
accurately reflect the nature of the problem that the message describes. 

If you want to change the message group to which individual messages are assigned, you can 
change the attributes of the message condition which generates the message in the first place. 
Note that messages generated by SAP’s database are originally assigned to the message group 
R3_CCMS but are then re-assigned to the message group R3_DB if a defined condition matches 
which shows that the message originates from a problem in an Oracle, DB2, or SQLServer 
database. 

The HPOM Message Browser Window 

The Message Browser window is your unique view of all active messages received at your 
display station from the managed nodes of the message groups assigned to you. 

You can use this window to review and manage messages and to guide problem resolution. 
Incoming messages are displayed with pre-configured attributes and status information. You 
can: 

•	 Look at all the details about a single message and, to resolve the message-triggering 
event: 

—	 execute an operator-initiated action, or 

—	 have HPOM perform an automatic action for you 

•	 Restart actions at any time or even stop the execution of an action 

•	 Print messages and prepare message reports 

•	 Document your actions and read through previously performed actions using HPOM’s 
annotation facility 

•	 Acknowledge messages in the Message Browser window after actions are completed 
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Figure 6 HPOM Message Browser 
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Understanding SAP-related Messages 

Incoming messages are displayed with pre-configured attributes and status information, 
which can be particularly useful in identifying and understanding SAP-related messages. 
Table 4 summarizes the message attributes you can use to identify a message in your browser 
as an SAP NetWeaver-related message. 

Table 4 SAP-related Message Attributes 

Message

Attribute


Application 

Message 
Group 

Object 

Description 

Identifies the application which was affected or detected 
the message cause. For the SPI for SAP, the application 
is always R/3, followed by a SAP system name and 
number. 

Identifies the message group to which the message 
belongs. For SPI message groups see Table 3 on 
page 100. 

Identifies the object which was affected by, detected, or 
caused the message. 

Working with SAP Messages in HPOM 

The Message Browser window is your most important source of information about the status 
of the managed nodes for which you are responsible. If you are logged on to HPOM as a user 
with SAP responsibilities, your Message Browser window will include messages from SAP 
NetWeaver managed nodes. 

When you select a message in the Message Browser window you can: 

• view a detailed description of a problem. 

• view instructions of how to deal with the problem. 

• initiate a pre-defined action. 

• add an annotation to document your actions. 

• acknowledge the message so that it is moved to the History Message Browser window. 

The example that follows shows a typical sequence of events when a critical message appears 
in the message browser. 
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Figure 7 Selecting a Message in the Message Browser 

1 Select the message in the Message Browser window. 

2 Click the Details... button in the Message Browser window. The system returns 
detailed information for the selected message. 
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Figure 8 Message Details 

3 Click the Instructions... button to read the instructions provided by the system. 

4 Once you have read and understood the instructions displayed in Figure 9 on page 107, 
click the Perform Actions button. The SPI for SAP automatically provides 
context-dependent access to the associated transaction. 

5 In this window, Use standard SAP methods to fix the problem. 

6 Return to the Message Details window shown in Figure 9 on page 107. 

7 Click the Acknowledge button to confirm your awareness of the message to which you just 
responded. Once you have acknowledged the message, the message is moved from the 
Message Browser window to the History Message Browser window. 
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Figure 9 Message Instructions 
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9 Integrating the SPI for SAP with HP Reporter

This section introduces the concept of service reports and explains how to use them in 
conjunction with the SPI for SAP and HPOM. The information in this section is designed 
specifically to help you use the service reports to manage the SAP environment in an efficient 
and convenient manner. 

What Are Service Reports? 

Service reports are web-based reports that are produced by HP Reporter (Reporter) using 
default templates and viewed using a web browser. Reporter allows you to request both 
scheduled and on-demand versions of reports. 

SPI for SAP service reports correlate the data extracted from either the Embedded 
Performance Component (CODA) or the HP Performance Agent. You can use the correlated 
data to generate reports which display short-, medium-, or long-term views of your IT 
environment and supplement the detailed, real-time graphs that the Performance Manager 
provides. The combination of reports and graphs is a powerful tool for trend analysis. For 
example, you can: 

•	 Identify potential bottlenecks in your IT system, so that you can take action before 
problems become acute. 

•	 Use the information to help you to make accurate predictions for future upgrades. 

•	 Collect accurate information to be used in measuring service levels. 
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Figure 10 SPI for SAP Service Reports 

Upgrading the SPI for SAP Reports 

If you are upgrading to version 11.00 from earlier versions, you can continue to use existing 
data and monitors. 

Upgrading the SPI for SAP reports in the manner described in this section removes 
from the Reporter system all old report data collected by the SPI for SAP. However, 
you can use database tools to preserve the tables containing information that you 
want to use after completing the upgrade process. For more information, see the 
documentation provided with the database product. 

1 Remove the old SPI for SAP reporter-integration package using the standard Microsoft 
Windows software-removal method: 

Start: Settings > Control Panel > Add/Remove Software 

2 Install the new SPI for SAP reporter integration as described in Installing the SPI for 
SAP Reports on page 111. 
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Installing the SPI for SAP Reports 

This section explains how to install the SAP service report which come with the SPI for SAP 
and, in addition, provides information designed to help you prepare for the installation. 

Before You Begin 

Before you install and set-up the SPI for SAP service reports, you must complete the following 
tasks: 

1	 Make sure either the Embedded Performance Component or the HP Performance Agent is 
running on all SAP managed nodes for which you want to generate service reports. 

2	 Make sure HP Reporter is available on an Microsoft Windows host. 

HP Reporter lite is no longer bundled with HP Operations Manager; you must 
install and use the full version of the HP Reporter to view SPI for SAP reports. 

You can install HP Reporter either on the HPOM management server or, to improve 
overall performance, on a separate system dedicated to the generation and display of 
service reports. 

3	 Make sure the SPI for SAP R/3 Performance Agent is available and configured on the 
machines for which you want to generate reports. 

4	 If you want to edit existing (or create new) service reports for the SPI for SAP, make sure 
that Crystal Reports is available on the machine hosting the HP Reporter. 

Installing SAP Service Reports 

The SPI for SAP inserts the SAP service reports into the HP Reporter product as a snap-in 
package using InstallShield. This means that the HP Reporter must already be installed 
before you install the SPI for SAP service reports. During set-up of the SPI for SAP service 
reports you will be asked to confirm or specify the common application path for HP Reporter. 

The common application path is the folder where HP Reporter is installed. The set-up 
attempts to discover this path automatically, and in most circumstances you should 
avoid changing it. 

The set-up copies components to the directories listed in Table 5. All directory paths are 
relative to the Reporter common-installation path. 

Table 5 Locations of SPI for SAP Service-Reports Components 

Component Directory 

Installation script 

Configuration files 

%OvInstallDir%\newconfig\ 

SAP report template files %OvReporter%\data\reports\SAP 
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To Install HP Reporter on the HPOM Management Server 

To be able to generate and view service reports for the SAP Systems you are monitoring with 
the SPI for SAP, you first need to install the full version of the HP Reporter. You can install 
the HP Reporter either on the HPOM management server or, alternatively, on a separate 
machine, which is not the HPOM management server. For more information about installing 
the HP Reporter, see the HP Reporter product documentation. After you install and configure 
the HP Reporter, you need to install and configure the SPI for SAP reports package on the 
same machine. 

If you install the HP Reporter on a machine which is not the HPOM management 
server, make sure the machine on which you install the HP Reporter can see the 
HPOM managed nodes, for which you want to generate service reports. 

To Install the SPI for SAP Reports 

The information in this section describes the steps required to add the SPI for SAP 
service-reports to an existing HP Reporter installation. When you have completed this task, 
the SPI for SAP service reports will be available in the HP Reporter GUI, and you will be able 
to use them to generate SAP-specific service reports, which you can view in a web browser. 

1	 Make sure that the HP Reporter is installed and configured on the machine where you 
want to install the SPI for SAP service reports. 

2	 Insert the HP Operations Smart Plug-ins media into the DVD drive of the machine where 
you installed and configured the HP Reporter. 

3	 Browse to the following folder: 

SPIs\SAP SPI Reporter Package 

4	 Locate, select, and run the following file: 

sapspi_reporter.msi 

5	 Follow the instructions to complete the installation 

Figure 11: SPI for SAP Reports InstallShield Wizard. 
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Configuring Report Packages 

The set-up process of the SPI for SAP’s service-report integration automatically performs the 
following tasks: 

•	 Creates new report group: SAP_R3 

•	 Assigns new metric list to the new SAP_R3 group 

•	 Assigns new group report to the SAP_R3 group 

•	 Assigns new system reports to the SAP_R3 group 

To Configure Report Packages 

1	 Verify that the installation of the SPI for SAP service reports completed successfully by 
confirming that the set-up process created the report and metrics groups listed in 
Configuring Report Packages on page 113. 

2	 In the Reporter console, browse to the Configure Report Packages window using the 
following menu option: 

File > Configure > Report Packages 

Check that the following package is present in the list of installed packages. 

•	 SPI for SAP 

3	 If you choose to add SAP Systems manually to the HP Reporter, note that you can use the 
following values in the Add System window: 

System host.name.com


Network SAP


Domain "SAP" as appropriate


Check that the set-up process added your SAP NetWeaver host to the appropriate 
Reporter group, namely; SAP_R3. The set-up process automatically assigns hosts to a 
report group according to the kind of data source (SAP NetWeaver), which it discovers on 
the monitored host. 

4	 Click OK; the systems appear in the Reporter’s details pane. 

5	 Use the Reporter GUI to schedule the generation of the SPI for SAP reports or generate 
them now using the option indicated below and illustrated in Figure 12 on page 114: 

Actions > Run > Generate Reports 
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Figure 12 SPI for SAP Reports and Metrics 

Removing the SPI for SAP Reports 

In order to completely remove the SPI for SAP reports, you need to perform the following 
steps. 

To Remove Reporter Snap-in Packages 

1 In Reporter, browse to: 

File > Configure > Reporter Packages 

2 Select the following files from the Installed Packages window located in the right pane of 
the Configure Report Packages window: 

• SPI for SAP 

3 Double-click the left arrow button to remove the selected packages from the Available 
Packages window: the selected packages appear in the list of Available Packages in the 
left pane of the Configure Report Packages window. 

4 Click OK to finish. 
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Removing Binaries from the HP Reporter System 

1 Go to the HP Reporter system. 

2 Insert the HP Operations Smart Plug-ins media into the DVD drive of the machine where 
you installed and configured HP Reporter. 

3 Run the HP Operations Smart Plug-ins wizard to remove programs. 

4 Select Remove Products. 

5 Select Reports under SAP SPI, and then follow the on-screen instructions to complete the 
deinstallation process. 
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10 Troubleshooting

All Smart Plug-ins and the add-on module now have access to improved SPI troubleshooting 
capabilities. Troubleshooting information can be obtained through the following method: 

Self-Healing Info application: This application can be run on any managed node supported 
by the SPI for SAP. When run, the application gathers data that you can send to HP support 
to diagnose the SPI problem. 

Self-Healing Info Application 

The Self-Healing Info application included with SPI for SAP can be run on the managed node 
to gather error message-specific and other relevant data. This data is stored on a compressed 
file that you can send to HP support for assistance. 

Selective Distribution of Files 

The SPI for SAP have been updated to allow selective distribution of their files. You can use 
the configuration file (seldist) on the HPOM management server to specify which node/node 
groups receive the named SPI files. By using this capability you can reduce the number of 
irrelevant files on nodes unrelevant to the SPI for SAP. 

Common SPI for SAP Problems 

Cannot launch the SAP GUI 

Problem: Cannot launch the SAP GUI tools from SPI for SAP remote console. 

Solution: Make sure the port 3330 is not blocked by the firewall. 

How to reinstall the SPI for SAP transports? 

Problem: If you want to install a SPI for SAP transport which is already installed, the 
transport will not work because SAP would prevent overwriting an already loaded transport. 

Solution: 

1 Start the SAP GUI as SAP* (in the client where the itouser is to be installed), and enter 
the transaction STMS (/nstms). 

a Click on the truck icon from Overview -> Imports (F5) to open the import queue list. 

b Double-click or mark the line for the system where the transport will be imported. 

c Go to Import Queue -> Display (F8)). 
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2 Select Extras -> Other Requests -> Add. A new window is displayed where the Transport 
name can be entered. 

a	 Select the "Import again" check box, if the transport was already installed and if you 
need to reinstall it. 

b	 Check and confirm the name and the import queue. 

c In the Import Queue window, the new request will be shown with Status (St column) 
"Request waiting to be imported" with a green square icon. 

3 Mark the next transport to be installed, and click on the second truck icon (for single 
installation, Request -> Import (Ctrl+F11)). A new dialog window will open with several tabs. 

a	 In the header line there is a target client field. Enter the client number of the itouser, 
or where it will be created. 

b	 If the transport has to be reinstalled, select the "Options" tab, and mark the options 
"Import Request Again" and "Overwrite Originals". You can ignore these options when 
the transport is imported for the first time. 

c	 Click on the green checkmark icon, and the transport will be installed. The Status will 
change to "Import running" (a truck icon). A refresh will later show the status as 
"Request is already imported" (a green checkmark icon). 

4	 Repeat steps 2 and 3 for all other transports to be installed. You can also perform step 2 
on all required transports, and then step 3 on all required transports. 

SPI for SAP restrictions with different SAP user types and SPI user roles 

The SPI for SAP provides two different SAP user roles:


1 ./HPOV/SAPSPI_MONITORING_TCODE 


2 ./HPOV/SAPSPI_MONITORING_NO_TCD


For more information on Setting Up an SAP User, see Configuring SAP-Specific Tasks in the 

SPI for SAP Install Guide for UNIX.


You can also set the user type of the SAP user (typically called ITOUSER, but may be called

differently) to either DIALOG or SYSTEM. In many SAP environments it is mandatory that 

each interactive SAP user changes the password regularly.


For a SYSTEM user such a requirement normally does not exist. Therefore there would be no

additional maintenance necessary for the ITOUSER. 


It is possible to assign both user roles /HPOV/SAPSPI_MONITORING_TCODE 
and /HPOV/SAPSPI_MONITORING_NO_TCD to the ITOUSER. 

SPI for SAP also provides one additional user role: /HPOV/SAPSPI_SECURITY_MON. The 
role /HPOV/SAPSPI_SECURITY_MON is used only to allow the r3monsec monitors to read 
the relevant SAP objects for monitoring. 

So that is independent from the user type (DIALOG/SYSTEM) and also independent from the 
choice of the user roles between /HPOV/SAPSPI_MONITORING_TCODE and /HPOV/ 
SAPSPI_MONITORING_NO_TCD. 

User type: DIALOG; User role: /HPOV/SAPSPI_MONITORING_TCODE  

In this combination there are no restrictions in the SPI for SAP functionality. 

User type: DIALOG; User role: /HPOV/SAPSPI_MONITORING_NO_TCD 
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In this combination the interactive login as ITOUSER is still possible but there are these 
restrictions in the SPI for SAP functionality: 

"Any SPI for SAP tools will not work that start a SAP GUI, login as ITOUSER, and start a 
certain transaction. These tools use the r3itogui executable to start a SAP GUI. 

"Any operator-initiated actions will not work that start a SAP GUI on the message host, login 
as ITOUSER, and start a certain transaction. These operator-initiated actions are defined in 
conditions of the "SAP R3 opcmsg" policy, and use the r3itogui executable to start a SAP GUI. 

How to prevent multiple same SPI for SAP monitors running 

Problem: If a SAP system is monitored by the SPI for SAP, and the SAP system has long

response time due to being overloaded, then it may happen that the SPI for SAP monitors do 

not get completed before the next monitoring cycle.


The SPI for SAP 09.xx versions implemented the templates/policies as MONITOR policies, 

whereas since 10.xx they are done as SCHEDULED policies.


The MONITOR policies expected an opcmon command back from the called executable with 

the name of the policy. When a policy was due for execution, this was used to check whether 

the previous monitoring cycle did in fact finish. If the previous opcmon call had not been 

received, an error was logged to System.txt on the agent, and this monitoring cycle was 

skipped.


Starting with SPI for SAP 10.xx, the executables do not send back such an opcmon command

anymore, and the policies are done as SCHEDULED policies, which do not expect an opcmon 

call either.


Solution: It is possible to create own policies as MONITOR policies, For example,

OWN_r3monal, OWN_r3monjob.


These policies first call the SPI for SAP executable and then call opcmon. The policy name is 

given as the parameter with any value.


If the managed node is UN*X, then the monitor call can simply be enhanced by appending the 

opcmon call. For example.


OWN_r3monal:


r3monal; opcmon OWN_r3monal=0


OWN_r3monjob:


r3moncol -cfgfile r3monjob.cfg; opcmon OWN_r3monjob=0


If the managed node is Windows, then the monitor has to call a script, For example,


OWN_r3monal:


OWN_r3monal


OWN_r3monjob:


OWN_r3monjob


And the scripts look like:


OWN_r3monal:


r3monal


opcmon OWN_r3monal=0


OWN_r3monjob:
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r3moncol -cfgfile r3monjob.cfg


opcmon OWN_r3monjob=0


 No SAP login defined for hostname in r3itosap.cfg file 

Problem: r3status can not login to the SAP system but instead sends a message: 

No SAP login is defined for hostname in r3itosap. The r3itosap.cfg file however contains a 
correct HostSapAssign entry. 

Cause: r3status scans the r3itosap.cfg file and compares the hostname provided in each 
HostSapAssign entry with its own hostname, thereby using name resolution. 

Example of a failing r3status: r3status.log (can be obtained with TraceLevel set to 3 in 
r3status.cfg) starts with: 

080918-11:02:19 Info : -----------------------------------------------------------­

080918-11:02:19 Info : Begin monitor run 

080918-11:02:19 Info : -----------------------------------------------------------­

080918-11:02:19  METHOD ENTRY: int CReadConfig::iGetSapLogonData(CObArray 
*mySAPLogonData, CObArray *myHostSapLogOnData) 

080918-11:02:19 Info : MyHostname - abcdef02 

080918-11:02:19 Info : Number of SAP Logon data in r3itosap.cfg 2 

080918-11:02:19 Info : Number of remote monitored machines 1 

080918-11:02:19 Info : sMyHostname:  - abcdef02 

080918-11:02:19  METHOD ENTRY: int CTools::iIPCompare("abcdef01.mydom.com", 
"abcdef02") 

080918-11:02:19  METHOD EXIT: int CTools::iIPCompare() = 0 

080918-11:02:19  METHOD ENTRY: int CTools::iIPCompare("abcdef02.mydom.com", 
"abcdef02") 

080918-11:02:19  METHOD EXIT: int CTools::iIPCompare() = 0 

080918-11:02:19 Info : Found SAP Login data for the Hostname:  - abcdef02 

080918-11:02:19  METHOD EXIT: int CReadConfig::iGetSapLogonData(CObArray 
*mySAPLogonData, CObArray *myHostSapLogOnData) = 0 

080918-11:02:19 ERROR: No SAP R/3 Login found for host: - abcdef02 

080918-11:02:19 METHOD ENTRY: bool OvItoMessage::Send() 

080918-11:02:19 Info : Nodename:    - abcdef02 

080918-11:02:19 Info : OpcMessage send:  - msg_text: No SAP login in r3itosap defined for 
hostname ; application: OpC/SAP; msg_grp: R3_State; object: SAPSystem; optionvar: 
MONITOR=; nodename: abcdef02 

The 1st comparison abcdef01.mydom.com fails because even the truncated hostname abcdef01 
is not equal to the actual hostname on this system. 

For the 2nd comparison the short hostnames match, so it does a nslookup (actually it uses the 
standard gethostbyname(3N) function) of both "abcdef02.mydom.com" and "abcdef02" and 
checks whether the results point to the same system. 
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In the above example the comparison fails (return code of CTools::iIPCompare() is 0 instead of 

1) which hints to a inconsistent name resolution.


Solution: 


After fixing the name resolution this step should work fine:


080922-12:24:01  METHOD ENTRY: int CTools::iIPCompare("abcdef02.mydom.com",

"abcdef02")


080922-12:24:01 Info : int CTools::iIPCompare() List of IP Addresses of - 

abcdef02.mydom.com


080922-12:24:01 Info : IP: - 10.11.12.13


080922-12:24:01  METHOD EXIT: int CTools::iIPCompare() = 1


080922-12:24:01 Info : Add new SAP Logon Entry for host - abcdef02.mydom.com 

So it is necessary to have a consistent name resolution on the SAP system. The actual 
hostname and the name provided in the HostSapAssign entry (after name resolution) must 
result in the same system. 

SPI for SAP sends messages with application field R/3 XXX XX 

Problem: A message appears in the browser from the SPI for SAP with:


Application: R/3 XXX XX


Message Text: OS_Collector : State : The OS collector (saposcol) is not running 

status=AL_STAT_ACTIVE severity=50


The application field does not give the SAP SID and Instance Number?


Solution: The application field normally has the SAP SID and Instance Number, For 

example, R/3 R70 00. This is done for SPI for SAP messages that can be attributed to a single 

SAP instance.


There are some SPI for SAP messages that refer not to a specific SAP instance. Other

examples of these are:


1	 Tool: R/3 R70 XX


Message Text : Process 'oracleR70 

(DESCRIPTION=(LOCAL=YES)(ADDRESS=(PROTOCOL=beq)))' is running 1 times 
instead of minimum 8 times 

Only the information about the SID can be extracted from the name of the database 
process. 

2	 Tool: R/3 XXX XX 

Message Text : Process 'oracleSID' is running 0 times instead of minimum 8 times 

The specification in r3monpro.cfg was: 

AlertMonPro   =ALL =oracleSID =1 =Min   =8  =CRITICAL  =orasrv =R3_State 

As none of the names of the running processes matched the pattern oracleSID, no SID can 
be extracted from the name of the database process. 

3 Tool: R/3 XXX XX 

Message Text : Process 'gwrd' is running 0 times instead of 1 

No information can be extracted from the name of the database process. 
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4 Tool: R/3 XXX XX 

Message Text : Process 'se.sapSID*' is running 0 times instead of 1 

The specification in r3monpro.cfg was: 

AlertMonPro =ALL  =se.sapSID*  =1 =Exact  =1 =CRITICAL  =se.sap    =R3_State 

As none of the names of the running processes matched the pattern se.sapSID*, no SID or 
Instance number is available. 

5 Tool: R/3 R70 XX 

Message Text : Process '/usr/sap/R70/SYS/exe/run/saposcol' is running 2 times instead of 1 

The SID can be extracted from the path of the process name, but no instance number. 

6	 Tool: R/3 XXX XX 

Message Text : Process 'saposcol' is running 0 times instead of 1 

The specification in r3monpro.cfg was: 

AlertMonPro   =ALL =saposcol  =1   =Exact =1  =CRITICAL  =saposcol  =R3_State 

As no saposcol process is running, no SID can be extracted from the path of the process 
name. 

DSI2DDF Error, did not find a datasource using the specified logfile set 

Problem: The following was seen on a Solaris 10 system with SPI for SAP for SAP installed: 

On the terminal window where the SPI for SAP r3perfagent was started, the following errors 
were displayed: 

/var/opt/OV/bin/R3PerfAgent/data/R3_myhost_TST_00_DATA: No such file or 
directory 

DSI2DDF Error, Did not find a datasource using the specified logfile set. 

Logfile Set Name: /var/opt/OV/bin/R3PerfAgent/data/R3_myhost_TST_00_DATA 

Cause: The nocoda.opt which is used for storing the database file is empty. 

# ls -l /var/opt/OV/conf/dsi2ddf/nocoda.opt 

-rw-r--r-- 1 root  root   0 Oct 15 14:45 /var/opt/OV/conf/dsi2ddf/nocoda.opt 

The datasource was created with r3perfconfig: 

# ./r3perfconfig 

Installed SAP Instances: 

SID   SapNr HostName 

(0) TST   00 MYHOST


Choose:


(x) to configure shown system


888 to manual configure a SAP system


999 to quit


0
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Creating new datasource: R3_MYHOST_TST_00_DATA 

.............  Datasource successfully created


The datasource has been setup in Coda, as can be seen with ovcodautil: 

# /opt/OV/bin/ovcodautil -obj 

Object Model 

NumDataSources = 2 

CODA 

R3_MYHOST_TST_00_DATA 

... 

The utility ovcodautil shows that no performance data has been stored yet: 

# /opt/OV/bin/ovcodautil -dumpds R3_MYHOST_TST_00_DATA 

== 

Empty instance list for R3_MYHOST_TST_00_DATA:DBINFO_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:JOBREP_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:SPOOL_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:UPDATE_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:WP_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:SYSUP_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:STATRECS_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:DOCSTAT_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:SAP_WLSUM_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:USER_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:SAPMEMORY_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:SAPBUFFER_PERF. 

Empty instance list for R3_MYHOST_TST_00_DATA:ICMSTAT_PERF. 

# 

The ddflbd.rc file shows: 

# cat /var/opt/OV/conf/dsi2ddf/ddflbd.rc 

DATASOURCE=R3_MYHOST_TST_00_DATA LOGFILE=/var/opt/OV/bin/R3PerfAgent/data/ 
R3_MYHOST_TST_00_DATA


So there is a discrepancy of upper/lower case characters here:


ddflbd.rc: LOGFILE=/var/opt/OV/bin/R3PerfAgent/data/

R3_MYHOST_TST_00_DATA 

error text: Logfile Set Name: 

/var/opt/OV/bin/R3PerfAgent/data/R3_myhost_TST_00_DATA 

In this case, the hostname is specified in upper case ('MYHOST') but 'nslookup MYHOST' 
returns the first name as 'myhost.mydom.com'. 
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During r3perfconfig the hostname is taken to offer SAP systems for configuration, whereas 
during r3perfagent the result from the name lookup is used to construct the file name. 

Solution: 

The name lookup should return the name in the same upper/lower case as the hostname itself. 

If fixing this inconsistency is not desired, or would create problems with other applications, 
then there are two alternatives: 

a	 Create the datasource manually using the 888 option in r3perfconfig file. 

This then prompts for hostname, SID, Instance Number. The hostname then has to be 
given in the same upper/lower case as it is returned by nslookup, in this example as 
'myhost'. 

b	 If the datasource has already been created, then a simple change of the ddflbd.rc file 
also fixes the problem: 

Edit /var/opt/OV/conf/dsi2ddf/ddflbd.rc and change from: 

DATASOURCE=R3_MYHOST_TST_00_DATA LOGFILE=/var/opt/OV/bin/ 
R3PerfAgent/data/R3_MYHOST_TST_00_DATA


to:


DATASOURCE=R3_MYHOST_TST_00_DATA LOGFILE=/var/opt/OV/bin/

R3PerfAgent/data/R3_myhost_TST_00_DATA


Note that the DATASOURCE name always is in upper case.


Then stop and restart r3perfagent, and verify that the errors do not occur anymore.


SYSUP_PERF collected around full minute, causing unwanted averaging in the 
Reporter 

The SYSUP_PERF within the r3perfagent is collecting its data once per minute.


But the interval is not always exactly 60 seconds but varies from around 57 to 63 seconds. For

example,


03/17/2009 22:01:59


03/17/2009 22:02:59


03/17/2009 22:04:01


03/17/2009 22:04:59


03/17/2009 22:06:01


So it may happen that within one minute there are two values present, whereas in the other 

minute there is no value at all. This variation is due to CPU load and other external effects,

and thus is outside the control of r3perfagent.


When the Reporter collects the data, it averages them to the full minute.


Typically this means that the single available value of that minute is taken. If there are two 

values present, then they are averaged to obtain the value of that minute. If there is no value 

present, then there will be no value stored into the Reporter database for that minute.


The result then is (empty lines were inserted as placeholders for the missing entries):


80564834 R3_MYHOST_TST_00_DATA 17.03.2009 22:01:00 17.03.2009


21:01:00 Swing 
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80564843 R3_MYHOST_TST_00_DATA 17.03.2009 22:02:00 17.03.2009 21:02:00 Swing


80564854 R3_MYHOST_TST_00_DATA 17.03.2009 22:04:00 17.03.2009 21:04:00 Swing


80564864 R3_MYHOST_TST_00_DATA 17.03.2009 22:06:00 17.03.2009 21:06:00 Swing


80564873 R3_MYHOST_TST_00_DATA 17.03.2009 22:07:00 17.03.2009 21:07:00 Swing


80564881 R3_MYHOST_TST_00_DATA 17.03.2009 22:08:00 17.03.2009 21:08:00 Swing


80564887 R3_MYHOST_TST_00_DATA 17.03.2009 22:09:00 17.03.2009 21:09:00 Swing


80564896 R3_MYHOST_TST_00_DATA 17.03.2009 22:10:00 17.03.2009 21:10:00 Swing


80564906 R3_MYHOST_TST_00_DATA 17.03.2009 22:11:00 17.03.2009 21:11:00 Swing


80564916 R3_MYHOST_TST_00_DATA 17.03.2009 22:12:00 17.03.2009 21:12:00 Swing


80564925 R3_MYHOST_TST_00_DATA 17.03.2009 22:13:00 17.03.2009 21:13:00 Swing


80564931 R3_MYHOST_TST_00_DATA 17.03.2009 22:14:00 17.03.2009 21:14:00 Swing


80564941 R3_MYHOST_TST_00_DATA 17.03.2009 22:16:00 17.03.2009 21:16:00 Swing


80564949 R3_MYHOST_TST_00_DATA 17.03.2009 22:17:00 17.03.2009 21:17:00 Swing


80564957 R3_MYHOST_TST_00_DATA 17.03.2009 22:19:00 17.03.2009 21:19:00 Swing


80564965 R3_MYHOST_TST_00_DATA 17.03.2009 22:21:00 17.03.2009 21:21:00 Swing


80564972 R3_MYHOST_TST_00_DATA 17.03.2009 22:22:00 17.03.2009 21:22:00 Swing


80564980 R3_MYHOST_TST_00_DATA 17.03.2009 22:23:00 17.03.2009 21:23:00 Swing


80564991 R3_MYHOST_TST_00_DATA 17.03.2009 22:24:00 17.03.2009 21:24:00 Swing


If there are too many of these occurrences per hour, this will be noted as unavailability by the 

Reporter. To overcome this effect, it has to be ensured that r3perfagent is started well away

from a full minute. The initialization of r3perfagent takes a few seconds. So, if r3perfagent is

started at 20 seconds past a full minute, then the SYSUP_PERF always occurs around 25-30 

seconds after the full minute, even if there are several SAP systems monitored on the same 

host.


For a UN*X type system, the r3perfagent.sh wrapper script can be copied to /var/opt/OV/bin/

R3PerfAgent/bin on the managed node, and then used instead of the r3perfagent binary.


You can also rename the original /var/opt/OV/bin/R3PerfAgent/bin/r3perfagent executable to

r3perfagent.orig, and call r3perfagent.orig instead of r3perfagent within the script, and then 

name the script itself to "r3perfagent".


Disclaimer: The r3perfagent.sh script is a contributed utility without support by HP.


r3perfconfig says: Valid datasource already exists 

Problem: During migration to SPI for SAP 11.xx, it is necessary to first: 

•	 uninstall the SPI for SAP R/3 Performance Agent before installing SPI for SAP 11.00 
(OMU) or 11.10 (OMW). 

•	 install/configure the new SPI Performance Agent. 

The uninstallation deletes the executables, but leaves the datasources with the previously 
collected SPI for SAP performance data intact. This is correct. 

When configuring the new SPI for SAP R/3 Performance Agent with r3perfconfig, after 
selecting the SAP system to configure: 
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# ./r3perfconfig


...


Valid datasource already exists: R3_grcdg515_R70_00_DATA


###################################################


The message "Valid datasource already exists" is displayed.


Checking the currently existing data sources reveals that the new Netweaver datasource has 

not been created.


Cause: The currently existing datasources can be checked either with 'ovcodautil -obj', or by 

checking the names of the dsilog files in /var/opt/OV/bin/R3PerfAgent/data, depending on 

where the performance data is stored. If this shows that there still exists a datasource for that 

SAP system (from the previous SPI for SAP version), then r3perfconfig will not add the new 

Netweaver datasource.


The workaround is to delete the old SPI for SAP datasource. This means that the previously

collected SPI for SAP performance data is removed from this node.


The old datasource can be deleted with the ddfutil command, which needs the logfile as 

parameter. This logfile name can be retrieved from the /var/opt/OV/conf/dsi2ddf/ddflbd.rc file:


# cat /var/opt/OV/conf/dsi2ddf/ddflbd.rc


DATASOURCE=R3_GRCDG515_R70_00_DATA LOGFILE=/var/opt/OV/bin/R3PerfAgent/

data/R3_grcdg515_R70_00_DATA


# /var/opt/OV/bin/instrumentation/ddfutil /var/opt/OV/bin/R3PerfAgent/data/

R3_grcdg515_R70_00_DATA -rm all


Then repeat the r3perfconfig. It then will create the old datasource again (but the previously 

collected SAP SPI performance data of course can't be restored), plus the new Netweaver 

datasource. The new ddflbd.rc file will then show e.g.:


DATASOURCE=R3_GRCDG515_R70_00_DATA LOGFILE=/var/opt/OV/bin/R3PerfAgent/

data/R3_grcdg515_R70_00_DATA


DATASOURCE=SAPSPINW_RPT_METRICS LOGFILE=/var/opt/OV/conf/sapspi/datalog/

data/SAPSPINW_RPT_METRICS.log


If the performance data is stored in Coda, this can be seen with:


# ovcodautil -obj


Object Model


NumDataSources = 10


...


R3_GRCDG515_R70_00_DATA


SAPSPINW_RPT_METRICS


NumObjects = 33


...


R3_GRCDG515_R70_00_DATA DBINFO_PERF


R3_GRCDG515_R70_00_DATA JOBREP_PERF


R3_GRCDG515_R70_00_DATA SPOOL_PERF


R3_GRCDG515_R70_00_DATA UPDATE_PERF
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R3_GRCDG515_R70_00_DATA WP_PERF


R3_GRCDG515_R70_00_DATA SYSUP_PERF


R3_GRCDG515_R70_00_DATA SAP_STATRECS_PERF


R3_GRCDG515_R70_00_DATA DOCSTAT_PERF


R3_GRCDG515_R70_00_DATA SAP_WLSUM_PERF


R3_GRCDG515_R70_00_DATA USER_PERF


R3_GRCDG515_R70_00_DATA SAPMEMORY_PERF


R3_GRCDG515_R70_00_DATA SAPBUFFER_PERF


R3_GRCDG515_R70_00_DATA EP_PERF


R3_GRCDG515_R70_00_DATA ICMSTAT_PERF


SAPSPINW_RPT_METRICS  SAPSPINW_RPT_METRICS


...


Data source: SAPSPINW_RPT_METRICS


NumMetrics = 6


SAPSPINW_RPT_METRICS  KEY  I32  METRICID


SAPSPINW_RPT_METRICS  KEY  I32  VALUEID


SAPSPINW_RPT_METRICS GGE R64 VALUE


SAPSPINW_RPT_METRICS  KEY  UTF8 SORTID


SAPSPINW_RPT_METRICS  KEY  UTF8  SERVERNAME


SAPSPINW_RPT_METRICS  KEY  UTF8  OBJECTNAME


#


"DATA_LENGTH_0" dumps when r3mondmp monitor is enabled in SPI for SAP. 

Problem: If the SAP table 'SNAP' contains corrupt entries, a "DATA_LENGTH_0" dump is

reported on SAP when SPI for SAP r3mondmp monitor is called.


In SPI for SAP, the error is reported in r3mondmp.log (when trace is enabled):


> 080929-16:41:22    ERROR: RFC CALL ERROR.KEY :


> 080929-16:41:22    ERROR: RFC CALL ERROR.STATUS :


> 080929-16:41:22    ERROR: RFC CALL ERROR.MESSAGE: - Invalid partial field access:

Length 0


> 080929-16:41:22    ERROR: RFC CALL ERROR.INTSTAT:


Cause: The r3mondmp monitor gets the ABAP dump event from the SNAP table. This table 

contains ABAP dump data.


The r3mondmp monitor seeks the SNAP table when the monitor is called. If the SNAP table 

has a corrupt entry, the r3mondmp monitor cannot seek correctly, and causes itself an ABAP 

dump.


Solution: This problem cannot be resolved on the SPI for SAP side. The corrupt entry needs 

to be removed from the SNAP table in SAP. Please refer to SAP Support in order to do this.


How r3monupd checks the database
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Problem: If in r3monupd.cfg the UPDATE_ERRORS_EXIST monitor is used, then

r3monupd may send a message like:


HOST=myhost:SID=TST:INSTNO=00:CLIENT=000:MONITOR=UPDATE:ATYPE=UPDAT

E_ERRORS_EXIST:9 Update errors occured;application: OpC/SAP;msg_grp:

R3_Update;object: UpdError; optionvar:MONITOR=r3monupd


How can this "9 Update errors occured" be verified in the SAP instance itself?


Solution:


UPDATE_ACTIVE


For alert type UPDATE_ACTIVE, whatever is displayed in the SM13 transaction under 
update system, the same is displayed in r3monupd transaction. This happens through the call 
to an SAP internal program. 

UPDATE_ERRORS_EXIST 

The results of r3monupd can be directly compared with the "Cancelled" update requests of the 

SM13 transaction for a particular date,time,client and user.


r3monupd collects all the records from table VBHDR where VBRC (the update return code in 

table VBHDR) is between 2 and 201. 


To get a dump of the VBHDR table:


On UN*X systems login as user ora<sid>


$ sqlplus "/ as sysdba"


SQL> select owner from dba_tables where table_name = 'VBHDR';


The resulting owner has to be used in the next statement to specify the tablename vbhdr.


The output from the SQL command will be logged in a file /tmp/vbhdr.txt. This file must not

exist when the spool command is executed.


For example, If the owner is reported as sapsr3, then the info from table vbhdr can be

obtained with:


SQL> select count(*) from sapsr3.vbhdr where vbrc >= 2 and vbrc <= 201;


SQL> spool /tmp/vbhdr.txt;


SQL> select vbmandt,vbusr,vbaccnt,vbreport,vbrc,vbname,vbstate,vbdate from sapsr3.vbhdr

where vbrc >= 2 and vbrc <= 201;


SQL> spool off;


SQL> exit


Check the file /tmp/vbhdr.txt for the entries. The vbdate is the date, vbmandt is the client id.
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11 Uninstalling the SPI for SAP

This chapter provides information on uninstalling the SPI for SAP software: 

•	 Removing the SPI for SAP through Graphical User Interface 

•	 Removing the SPI for SAP through Command Line Interface 

Removing the SPI for SAP through Graphical User Interface 

To remove the SPI for SAP using X-Windows client software, perform the following steps:


1 Login as a root user.


2 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Linux 

management server. Mount the DVD if necessary. 

3	 Start the X-windows client software and export the DISPLAY variable by typing the 
following command: 

export DISPLAY=<ip address>:0.0 

4	 To start the removal of the SPI, type the following command: 

<DVD-ROM mount point>/HP_Operations_Smart_Plug-ins_Linux_setup.bin 

The Application Maintenance window opens. 

5	 Select Uninstall and click Next. 

The Pre-Uninstall Summary window opens. 
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6 Click Uninstall. 

The Uninstalling window opens. The Uninstall Complete window opens once the SPI is 

uninstalled. 

7 Click Done to complete the removal of the SPI. 

Removing the SPI for SAP through Command Line Interface 

To remove the SPI for SAP through command line interface:


1 Login as a root user.


2 Insert the HP Operations Smart Plug-ins DVD into the DVD drive of the Linux 

management server. Mount the DVD if necessary.


3 To start the removal of the SPI, type the following command:


./HP_Operations_Smart_Plug-ins_Linux_setup.bin -i console 

4 Type enter option here to start the uninstallation. 


5 Type the number corresponding to the feature you want to remove.


6 Click Enter to continue.


When you have two SPIs installed on the Linux management server and you want 
to remove one SPI out of the two installed SPIs, select Modify (1) option and 
then the SPI you want to retain. Do not select the SPI which you want to remove. 

When the removal is complete, you will receive a message which states that the removal is 
completed successfully. 

Removing SAP R/3 Performance Agent from SAP Managed 
Nodes 

To remove the SAP R/3 Performance Agent from the managed node, you need to perform the 
following steps in the order indicated: 

1	 Before starting the process of removing the SAP R/3 Performance Agent from the 
managed node, make sure that you stop the SAP R/3 Performance Agent, for example; 

—	 Use the SPI for SAP tool, PerfAgt Stop, which resides in the SPI for SAP > SAP R/3 UN*X 
or SPI for SAP > SAP R/3 NT tool group. 

—	 Use the following command as user root on the command line: 

r3perfagent stop 

2 From the Tool Bank window, go to the SPI for SAP group, and then run the following 
tools: 

—	 Run the Remove Performance Package (UNIX) tool on UNIX nodes 

—	 Run the Remove Performance Package (Windows) tool on Windows nodes 
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Removing the SPI for SAP Objects from Managed Nodes


Apply the removal transport from the R3Trans.car file on all the SAP nodes to remove all 
objects added by the SPI for SAP. See the Applying the SAP Transport on page 32 section for 
information on applying an SAP transport. 

Removing the SPI for SAP from HPOM Managed Nodes 

To de-assign and remove SPI for SAP management functionality from HPOM managed nodes: 

1 Open the All Policy Assignments window and select SPI for SAP nodes. 

2	 Select Deploy Configuration from the Choose an action drop-down box and click Submit 

. The Selector window appears. 

3	 Select Policies and Force Update and click OK. 

4	 Use the Delete Config tool to remove any global- configuration files that exist for any 
SPI for SAP managed nodes, for example; by selecting in the Node Bank window all the 
managed nodes from which you want to remove the SPI for SAP, select the Delete 
Config tool icon from SAP R/3 Admin tool group. 

Deleting SPI for SAP Message Groups 

To delete SPI for SAP message groups:


1 Open the All Message Groups window.


2 Select SAP SPI message groups.


3	 Select Delete... from the Chose an Action drop-down box and click Submit

Deleting SPI for SAP User Profiles 

To delete SPI for SAP user profiles:


1 Open the All User Profiles window.


2 Select SAP SPI users.


3 Select Delete... from the Chose an Action drop-down box and click Submit 

. 
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A Using a Non-Privileged Windows User with the 
SPI for SAP 
Refer 

By default, the SPI for SAP tools and policies run under the $AGENT_USER account that has 
been configured with HPOM while adding the SAP node to the management server. If you use 
the HP Operations agent version that supports the use of a non-privileged user, 
$AGENT_USER does not need to be an administrative user. 

To use a non-privileged Windows user with the SPI for SAP, follow these steps: 

1	 Install the HP Operations agent on the managed node. 

2	 Change the default agent user (Local System) to a non-privileged user. 

Refer to the HTTPS Agent Concepts and Configuration Guide for more 
information on changing the default agent user. 

Additional Requirements 

While using a non-privileged user as $AGENT_USER with the SPI for SAP, the following 
policies and tools must be provided with the user credentials of a user with additional 
privileges: 

•	 PerfAgt START and PerfAgt STOP tools: You must provide these tools with the rights 
to be able to start or stop the SPI for SAP R/3 Performance Agent service. Alternatively, 
you can enable the non-privileged user—which you plan to use as $AGENT_USER—to be 
able to start and stop the SPI for SAP R/3 Performance Agent service. 

•	 Install Performance Package (Windows) and Remove Performance Package 
(Windows) tools: You must use the Install Performance Package (Windows) and Remove 
Performance Package (Windows) tools with an administrative user. 
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